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ACCESSING YOUR ISSUES

SINCE WE SWITCHED to digital a while
ago, I’ve been inundated with emails
from print subscribers asking me how
to access their new digital subscription.
I have it on good faith that our digital
marketing team have already sent out a
mass email explaining what’s going on,
and what to do, but unfortunately I
don’t think it’s managed to reach
everyone. That’s not entirely surprising,
given how hit and miss digital
correspondence can be — some emails
will inevitably end up not sending for
some reason, some might go in the
spam, and some might even end up
being missed or deleted by mistake.

Many of our readers also didn’t provide an email when they
signed up for their print subscription, meaning we had to post
out a letter instead. Now, it’s entirely feasible that this method of
communication is actually somewhat more reliable than the
digital counterpart, but naturally this isn’t a 100% perfect
process. So, if you’re wondering what’s happening, then we’ve
not forgotten about you — we just haven’t been able to get in
touch. If you are reading this, maybe because you bought a single
issue in the hope of finding out, then this is the information I
was given: Step 1, you need to activate your digital subscription at
https://bit.ly/3GLkacp. Scroll down to the Dedicated iOS
magazine apps instructions to set up your subscription. If you
already have a Pocketmags account, you will still need to do this
as the back issues are exclusive to this app. Once this is set up
you will have access to your subscription. Access to your back
issues will be there as long as you are a subscriber. Step 2, access
your digital bookazines at https://bit.ly/41sYeKR. Follow the
detailed instructions at the top of the page. Hopefully that should
do the trick! Do get in touch, if not.

Speaking of email correspondence, don’t forget to sign up to
my exclusive email newsletter by turning to page 79. There’s a QR
code that you can scan, which makes it super easy to sign up.
Every month you’ll get the latest news from me, and if there are
any major changes at Mac/Life, you’ll be the first to hear! m

Wik

NICK ODANTZIS, Editor

Twitter: @maclife

Editor's opinion
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Matt Smith

Art Editor

Matt, previously of Mac/Life
fame, couldn't resist coming
back on board for another
issue to cover, but he assures
me it's just a one-off..

Rachel Terzian
Production Editor

The Reminders app (see p61)
is so handy, especially for
someone like Rachel, who
loves to create lists for pretty
much everything.

Rob Mead-Green
Contributor

Rob's CarPlay superguide
(p52) is highly recommended
— afterusing it for a few
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SHARE YOURTHOUGHTS FACEBOOK: facebook.com/maclife months he’s not sure how we
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iIPhone 15
preview

What's coming in the
next iPhone model?

BY ALEX SUMMERSBY

THE iPHONE 15 line due this year
promises a big shakeup in several
respects. Here is what we expect.

First up, instead of Lightning, the
iPhone 15 will have a USB-C port, as
ordered by the EU for all devices sold
in Europe as from the end of 2024.

All models’ screens are likely to
lose the notch and feature Dynamic
Island, the variable interface element
introduced in iPhone 14 Pro to
camouflage the front-facing camera
and other under—screen components.
Aside from this, the 6.1-inch iPhone
15 and 6.7-inch iPhone 15 Max are said
to have screen sizes and body designs
much like the current model’s, with
an aluminum frame and toughened
glass front and back.

By contrast, significant design
changes are expected in the 6.1-inch
iPhone 15 Pro and 6.7-inch iPhone 15
Pro Max. These include a titanium
frame, both lighter and stronger
than aluminum, with more rounded
corners and thinner screen bezels.

Some sources said the Pro models
will be getting brighter, more power—
efficient OLED display tech, with a
maximum brightness up to 2,500 nits
— possibly the brightest screen ever
on a phone — but recent reports say
this won’t happen until the iPhone 16.

It is believed the Pro models will
have ProMotion adaptive refresh rate
technology and always—on displays.
The regular iPhone 15 models, though,
are expected to have the same 60Hz
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displays as current models, now
somewhat behind the industry curve.
Early rumors said the Pro models
would also have a solid-state mute
switch and volume buttons, each with
a dedicated haptic engine underneath
for feedback. However, the latest
reports say Apple is facing technical
issues with the technology and all
models will have the familiar buttons.
Even so, one source claims the iPhone
15 Pro models will have a customizable
Action button, like that on the Apple
Watch Ultra, instead of a mute switch.

LATEST PROCESSOR TECHNOLOGY
Inside, the iPhone 15 Pro models are
expected to introduce a new A17 chip,
the first processor fabricated using
chipmaker TSMC’s next—gen 3nm
process. This is said to increase
processing performance by 10-15%
while reducing power consumption
by up to 35%, promising even more
responsive apps and better battery
life. The standard iPhone 15 models
are believed to have the 4nm A16
Bionic chip used in the iPhone 14 Pro.
All iPhone 15 models will reportedly
use a Qualcomm modem chip,
probably the X70, instead of Apple’s

own 5G modem chip, which is still in
development and won’t be ready until
2024 at the earliest. However, Pro
models could gain Wi-Fi 6E, which
offers faster connectivity, lower
latency, and greater bandwidth than
the current models’ Wi-Fi 6.

According to analyst Ming-Chi Kuo,
the Pro models will support “at least”
USB 3.2 or Thunderbolt 3, which would
mean much faster data transfer (up to
20GDb/s or 40Gb/s respectively, as
compared with 480Mb/s for USB 2.0).
However, there are reports that faster
data speeds — and fast charging —
will be possible only with accessories
certified to Apple’s Made for iPhone
(MFi) standard.

Finally, the camera in iPhone 15 Pro
is rumored to be a major upgrade, with
periscope lens technology that offers
6x or even 10x optical zoom, compared
to the 3x in current Pro models, and
possibly all-new sensor tech capable
of capturing more light, for better
exposure in varied lighting conditions.

Apple usually releases new iPhone
models in September. Pricing is
expected to be unchanged — 6.1-inch
models starting at $799 and 6.7-inch
from $899.

Image rights: Apple



> Apple goes even greener
On track to decarbonize production by 2030

APPLE HAS ANNOUNCED that its
manufacturing partners now support
13.7 gigawatts of renewable electricity
around the world, which is an increase
of nearly 30% in one year. In total, more
than 250 suppliers operating across 28
countries are committed to using
renewable energy for all Apple
production by 2030. This represents
more than 85% of the company'’s direct
manufacturing spend and more than 20
gigawatts in commitments.

Apple itself is already carbon neutral
for its global corporate emissions, and

has called on its suppliers to
decarbonize all Apple-related
operations, including sourcing 100%
renewable electricity. More than 40
manufacturing partners joined Apple's
Supplier Clean Energy Program in the
last year, and Apple has committed
$4.7bn in Green Bonds, which are
helping finance the expansion of
clean energy solutions and emissions
reductions around the world through
investments in large-scale solar, low-
carbon design, energy efficiency, and
carbon removal.

> Apple expands in India

APPLE IS GRADUALLY reducing its
reliance on China as its manufacturing
base and last year made S7bn worth of
iPhones in India. This was almost 7% of
global iPhone production, growing from
just 1% in 2021. According to a report by
JP Morgan, Apple is planning to expand
its manufacturing capacity in India to
produce 25% of all iPhones by 2025.

At the same time, it is also opening
its first two Apple Stores in India, Apple
BKC in Mumbai and Apple Saket in
Delhi. Although Apple products have

Image rights: Getty Images.

been available in India for 20 years, the
Indian government only recently eased
restrictions on foreign-owned single-
brand retail stores.

IDC estimates that Apple has a 60%
market share in the Indian “premium
smartphone” market (phones costing
40,000 rupees — about $490 — or
more), but this is a tiny slice of the
country’s notoriously price-sensitive
market — around 5%. The average salary
in India is less than 30,000 rupees or
about $367 a month.

The latest news from the world of Apple

News in
brief

A bite of the Apple

> IMPORTANT UPDATES

Apple has urged all users to install the
latest security updates — i0S 16.41,
iPad0S 16.4.1, and mac0S 13.3.1 — to fix
a couple of serious security issues. It
says of each: “Apple is aware of a report
that this issue may have been actively
exploited,” which is as close as it gets
to confirming that unpatched systems
are at immediate risk. There are also
security updates for older phones that
still run older iOS versions, a move also
indicative of serious vulnerabilities.

The security updates have arrived not
long after i0S/iPad0S 16.4 and mac0S
13.3 Ventura, which delivered a number
of enhancements:
> 21 new emojis are introduced (31if you
count skin tone variations), the first new
emojis in more than a year.
> There is now an option to receive push
notifications from Safari (from sites you
have saved to your Home screen).
> Voice Isolation mode, an option in
FaceTime for some time, is now
available for phone calls too.
> Freeform gains a Remove Background
option, which automatically isolates a
subject from the image background.
> Duplicate photos and videos can now
be detected in Shared Photo Libraries
as well as local ones.
> Among other things, there are also
updates to the HomeKit architecture
and podcasts, plus the return of the
page-turn animation in Apple Books.
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IPad Pro vs
MacBook Air

Apple's hardware lineup is becoming increasingly confusing.
CHARLOTTE HENRY tries to unpick it all

|— here is little more thrilling

T for an Apple fan than
getting to pick out a new

I_ Mac. You walk into the

shop and tell the staff member which

new essential work item you’re going

to buy; almost as thrilling is

building your perfect machine in

the online store.

In recent years, that process has
become a lot more confusing though.
Products across the company’s range
seem to have become more and more
similar, and it’s not just across the
Mac offerings. Some iPads are now so
powerful it is hard to distinguish them
from what we would traditionally
think of as a laptop.

So, for example, assuming you do
not need the most powerful Mac and
are mostly looking for portability, do
you want a MacBook Air or an iPad
Pro? Making a decision based on price
and features is not straightforward.

6 | MAY 2023

The lowest specification MacBook
Air available at the time of writing
contains the M1 chip, an 8—core CPU
and 7-core GPU. The iPad Pro,
meanwhile, also has an 8—core CPU
but boasts a 10-core GPU and M2 chip.
The MacBook Air does have a slightly
larger display — 13.3 inches compared
to 11 or 12.9 inches offered by the iPad
Pro — but that is one of the only key
criteria on which the laptop “wins”.

The iPad Pro starts at $799 for the
11—inch or $1,099 for the 12.9-inch
display. However, including a
keyboard adds either $179 (Folio
Keyboard) or $299 (Magic Keyboard) to
the bill. The MacBook Air costs from
$999. There is a newer M2 version of
the laptop available, but this doesn’t
exactly help clear up the confusion. It
can be purchased with a 10-core GPU
and 13.6-inch display for $1,499. It all
just means that both the Air laptop
and the iPad Pro are running on the

same Apple silicon, and depending on
your needs may lead to similar costs.

Far from worrying about this
development, Apple has been keen to
embrace it. When it released an iPad
Air with the M1 chip in March 2022, its
ad for the device ended with the
tagline “your next computer is not a
computer”, with the promo clip
showing off the flexibility and
versatility of the tablet.

CONFUSION REIGNS

Dave Hamilton has spent years giving
Apple users advice on the popular Mac
Geek Gab podcast. He told us:
“Today’s iPad vs MacBook decision
really comes down to what,
specifically, you plan to do with your
device. The MacBook can do
‘everything’, but it’s not (quite) as
convenient for reading or quick, on-
the-go interactions. If the apps you
need are available on iPad and

Image rights: Apple Inc.



workflows are suited to your liking,
then an iPad really can be the right
device. But if you have any questions,
a MacBook is likely the safe choice.”
Similar confusion can be found
within Apple’s desktop Macs too. The
latest Mac mini can be bought with an
M2 or M2 Pro chip inside. The older
iMac 24-inch still has the M1 chip.
The Mac mini has a 10-core GPU while
the iMac has a 7— or 8—core one. The
Mac mini costs from $599, but looking
at price points is not particularly
useful in this instance as you may

need to buy a display and other
accessories for it. That said, it may
well still come in at less than the
cheapest iMac, which costs $1,299.
Unless you feel strongly about the
colors the iMac comes in, the mini
might seem the more tempting
option. However, some people like the
unified nature of the iMac and don’t
want the extra fuss of researching and
buying additional peripherals.

At least within individual product
lines things are relatively clear. For
instance, Apple sells 13-, 14—, or 16—

The latest news from the world of Apple

inch MacBook Pros, with the M2 Pro/
Max chips available in the larger two
models. This is also true across the
current range of iPads. The 10th
generation, entry—level iPad has an
A14 Bionic chip, while the latest iPad
Air has an M1 chip, and the iPad Pros
are powered by M2 chips. The
difference in hardware is naturally
reflected in the price. Your budget is a
fairly fixed factor; it’s deciding which
product line you want to purchase
from in the first place that’s becoming
increasingly complicated. =
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Your next computer IS not a computer

At the launch of the M1iPad Air, Apple’s “Your next computer is not a computer” slogan emphasized the power of the tablet.

LESS IS MORE, MORE IS...
Obviously, customers should delve
into the spec comparisons more
deeply to find what’s best for their
particular needs. However, not
everyone has the time or tech know-
how to do this. While choice is a good
thing — we all have different needs
and budgets — clarity is also
important when buying big-ticket
items like a Mac.

It’s also worth bearing in mind that
the differences outlined are in no
small part caused by products having

different upgrade cycles. There can be
little doubt we will get a faster Apple
silicon iMac in the future (more likely
M3 than M2). The MacBook Air will
likely get an upgrade too...

The fascinating thing about this
shift is that it is the total opposite of
what Steve Jobs set out to do when he
returned to Apple in 1997. In his
definitive biography of Jobs, author
Walter Isaacson explains how the
Apple co—founder was deeply
frustrated by the number of products
the company made and how this was

v e
-

- | e

A Mac mini is an affordable way to up spec, but you've got to add peripherals to your overall spend.
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confusing consumers. In typically
ruthless fashion, he quickly cut many
of them.

According to Isaacson, “After a few
weeks Jobs finally had enough...
‘Stop!” he shouted at one big product
strategy session. ‘This is crazy.’ He
grabbed a magic marker, padded to a
whiteboard, and drew a horizontal and
vertical line to make a four-squared
chart. ‘Here’s what we need,’ he
continued. Atop the two columns
he wrote Consumer and Pro; he
labeled the two rows Desktop and
Portable. Their job, he said, was to
make four great products, one for
each quadrant.”

One can only imagine what Jobs
would make of the wide-ranging set
of computers and tablets on offer
from the company today. It is fair to
say that a modern Apple cannot be
quite as simplistic as it was just over a
quarter of a century ago. It now
thrives by offering top—end products
in a host of categories. It’s not just
about Macs, iPads, and iPhones either.
Wearables like AirPods or the Apple
Watch are all crucial products too.
However, that does not necessarily
mean that the crossover within the
Mac lineup and between Macs and
top—end iPads need be as tricky to
navigate as it is.



DECIDING WHICH
PRODUCT LINE

TO PURCHASE
FROM IS BECOMING
INCREASINGLY
COMPLICATED

SOFTWARE SIMILARITIES

It’s not just on the hardware side
where clashes occur either. While it is
absolutely true that macOS remains
much more powerful than its
equivalents for iPhone and

iPad, Apple’s operating ! L

—_—

systems are becoming
increasingly similar. This became
particularly apparent with the release

of macOS Ventura in October last year.

It closely resembles iPadOS and iOS,
themselves now almost
indistinguishable.

This is in large part entirely
justifiable. The resemblances in
design between the Mac operating
system and the mobile ones make it
easier for users, particularly less
experienced ones, to know how to
complete the same task across
different devices. For example,
System Settings in macOS Ventura
looks a lot more like Settings in i0S

INENsC0NGIEN-TYRRERE ¥ o

Thanks to Continuity, you can start something on one Apple device and move seamlessly to another.

and, amongst many other things, it’s
now much simpler to change a Mac’s
wallpaper. The option is now clearly
visible, not hidden deep in the
settings as it was on previous versions
of macOS. Similarly, Handoff, which
lets you easily open on one device a
browser tab or app already in use on
another, provides ever smoother
workflows. This ease of transition
across devices is without a doubt
hugely beneficial. It does not matter
which device you start a variety of
tasks on as you can easily continue

With a Magic Keyboard, the iPad Pro is becoming increasingly similar in use to a MacBook.

them on another. Features like this
increase the sense of a complete
ecosystem in which the Mac, iPad and
iPhone all integrate seamlessly. This
helps Apple as it makes it even more
enticing to only use its products and
commit to the brand.

However, any simplifications
caused by increasing similarity across
the operating systems could
potentially mean features required by
Mac power users are dumbed down or
harder to access. Crucially, if the
functionality seems almost the same,
it makes it even less clear what device
is actually right for any particular user
to invest in.

WHAT DO | NEED?

Ultimately, there is no right or wrong
answer to any of this. All purchasing
decisions come down to what you
need and when you need it. It may
simply not be possible to buy the
perfect device at the perfect time.
You may have to settle for a slightly
older chip or compromise on other
specs or features. However, there is
little doubt that in recent years
Apple’s product lineup has become
increasingly full and confusing,
making buying a device just that bit
more difficult for anyone who’s about
to spend a whole lot of money. ®
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THERE'S BEEN A LOT OF

> THE SHIFT

MATT BOLTON is wondering whether
ChatGPT is a danger to Apple, Siri's savior,
or just another API to support

VER THE LAST few weeks, the
single most dominant tech
story has been ChatGPT, and
its eerily good ability to
create written documents from an
“AI” database. Well, I say “single”,
but what’s been written about it
has gone through so many
transformations — from “Wow,
this thing is amazing!” to “Oh, this
thing is terrifying” to “This will
make my life much easier” to
“This will put me out of a job” to “I
can get any information digestible”
to “Ah, it just makes up facts
sometimes” and “Oh no it also
might throw in slurs”, and so on.
A lot of talk about it has been
focused on where people

TALK, BUT CHATGPT

TECH IS NOT YET READY

FOR PRIME TIME..

T L e e e
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The conflation of information here is impressive; flights
from an airport, time to get there, and places to visit.

will access it in practice. Microsoft
sees Al as a way to do the
impossible and leapfrog Google in
search, adding it into Bing in a trial
that’s live now. Ask Bing a
question and you’ll get an answer
that ideally makes sense and is
accurate, but the latter of those in
particular is not guaranteed.

Microsoft is already pushing
Al-powered tech as a way to
compose copy too — an Al
assistant can be used in the Edge
browser to write posts on LinkedIn,
which is a terrifying thought. I
really don’t know that the platform
needs an easier way to post
complete drivel on it.

One company silent on ChatGPT
so far is Apple. I think this is
no bad thing — the technology
is not ready for prime time,
and how “acceptable” we’ll
find it is far from settled. But
it’s certainly in Apple’s
wheelhouse — consider how
the company uses other types
of machine learning in photos
and battery management and

predicting what apps you’ll use, all
to make life easier — so I wonder
what it’s thinking about it.

Maybe it gives Apple the chance
to create its own search engine, as
it has supposedly wanted for a
while. But I can’t see the company
liking the idea of the possibility
that an Apple-branded product
might tell you that it’s safe to boil a
baby (as Bing’s version did for
a moment, reportedly).

Siri has been stagnating
compared to other voice assistants,

EEENRY

Few ideas are odder than that of choosing a
topic, opting for a chipper tone, and then
posting it as your own.

and ChatGPT could be an incredible
opportunity there. Use Siri’s voice
recognition to identify knowledge
questions, feed them to ChatGPT,
and have Siri read out the answers.
It has the same risks as those
mentioned, but maybe Apple would
be more willing to take them since
Siri is an existing product that
needs a boost.

Or maybe Apple will take no
stance at all. Maybe it’ll promote
that if developers want to use
ChatGPT in their apps, the A-series
and M-series chips do it faster
than anything else on the planet,
but it’ll keep clear of the tech
itself. Maybe it’ll include Bing’s Al
search in Spotlight, again keeping
it clear that it’s another company’s
results, and with the option to turn
it off — an arm’s length away from
any worrying results.

We’re on the precipice of
something, make no mistake. But
what happens next is as much
about politics as it is technology,
and we should not underestimate
the power of the former to steer
the latter.

>>> Matt is Managing Editor at www.TechRadar.com, and previously worked on T3, Mac|Life and MacFormat. He's been
charting Apple’s ups and downs since his student days, but still hopes to hear “one more thing".
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LETTER OF THE MONTH

On the scale of frustrations in
life, this is pretty low on the list,
but it’s annoying enough that
I’ve tried to figure out how to
deal with it — and can’t. SoI’'m
contacting the ultimate
authority: YOU ALL!

I use Apple Mail on my
MacBook, iPhone, and iPad, all
synced via iCloud. I’m accessing
emails from several Gmail
accounts; an old professional
account; and my mac.com and
iCloud.com accounts, which are
what I use for most of my
personal correspondence. I’'m a
pretty fast typist, so I prefer to
answer emails from my
MacBook, but I also sort, read
and respond to some emails on
my cell phone.

On the iPhone, I’d like to be
able to deal with every message
in the same way: for example, I
want to be able to swipe right to
archive a message
and swipe left to
delete it. But
there doesn’t
seem to be any
consistency to the
way these
gestures work in
Mail on the
iPhone, and I
can’t find any way |
to achieve any

lan & Keahia

T —

Alox Blake

messages, I can
swipe right and
delete them. For
others, I have to
go through a
longer process,
which involves

Alex Fliske
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EMAIL: letters@maclife.com
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selecting folders and dropping
the message into the trash. I
believe that this has some
relationship to whether the
messages are from iCloud or
Gmail and may relate to how the
various folders are set up for
these accounts. But I can’t find
any documentation, anywhere,
that helps me figure out how to
make the gestures the same for
every message.

Does this make sense? And
how do I fix it? Thank you.
MICHAEL STONER

Michael, I too have noticed this
same behavior when swiping left
on emails from different account
providers, where some will have
the option to delete the message,
while others will have the option
to archive it instead.

From what [ understand, you are
absolutely correct in saying that
the default action
for each mail
account can be
different.
Thankfully for us,
this default action
isn’t set in stone,
and it can be
changed in the
Settings menu. In
here, tap Mail >
Accounts. Tap on
the account you
want to edit, tap
Account once
more, and tap
Advanced. Under
where it says
“MOVE
DISCARDED
MESSAGES INTO:”
choose either
Deleted Mailbox or
Archive Mailbox.

Ohutlcck tor Maz in Mad f= magasme

consistency so
that they all work Al Blakn
the same way for
every message.
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Legibility issues
| read every page in your magazine. | love
it and find things of interest in most every
issue. However, | find the faint printing of
your answers to the questions makes it
rather hard for me to read, especially if
the ambient light is not very bright.
Since you have a full page line drawn
between the question and answer, | can
find no way that the answer cannot be
done in black and/or bold print. Give it a
long thought please.
ROBERT WHETSTONE, WISCONSIN

| really appreciate the feedback Robert,
and I've been aware of the issue for some
time now. The main problem is down to
the quality of the printed paper, which
over the years has been reduced. We've
tried our best to mitigate this by
choosing shades of gray that aren‘t
affected so much.

Yes, we could just make the question
and answer in the Ask section all one
shade, as you suggest, but then the
section would look very heavy (and in all
honesty, also not very pleasant from a
design perspective).

Fortunately, that won't be a problem
for you going forward as we've now
made the magazine exclusively digital.
Unlike the print edition, what we see on
our Macs when we're designing it is
exactly what you see when you read it on
an iPhone or iPad (albeit in a different
scale). This makes the magazine look as
we intended, and consequently it's much
easier to read.

AirTag share

Is there any way to share an AirTag with
more than one person? Any chance Apple
might add that feature?

KAT ANTIGONE, TROWBRIDGE

That's a great question Kat.
Unfortunately, an AirTag can only be
assigned to a single Apple ID, and so
there is no way to share an AirTag with
another person/Apple ID. In future, Apple
may allow sharing of AirTags within
Family Sharing, but it's doubtful due to
ongoing privacy concerns.

Mac|Lifes®
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54 Genius Tips

THINGS TO DO WITH YOUR
MAC, IPHONE, AND IPAD

Your Apple devices are extremely versatile, offering a
multitude of ways to be creative, stay safe, learn skills,
discover new hobbies, and much more...

WRITTEN BY IAN OSBORNE

HE FLEXIBILITY OF what you
can do with your Apple gearis
amazing. Apple tech is so

versatile; there’s just so much you can
achieve with a Mac, iPhone, iPad or Apple
Watch. In this in-depth guide, we round up
some of the best tips and tricks that
enable you to be more creative,
productive, solve problems, and features
you might not have anticipated. Want to
use your iPad as a drawing tablet? You
can. Would you like to ask Siri to remember
where you parked your car? We show you
how. Ever wanted to write a novel or
screenplay on your Mac? Discover the

best way to get started. You can get

an ECG, blood oxygen test, and loud o
environment report directly from your

Apple Watch too.

For many of these tips, you already
have everything you need bundled with
your device's operating system. For
others, you might have to buy an extra
app. though we've mostly concentrated
on low-cost software.

So what are you waiting for? Take a
look at our collection of interesting
projects for all your Apple gear, and start
to use your desktop or notebook Mac,
iPhone, iPad, or Watch in a whole new way.

® . MAY2023 13
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On the Mac

Amazing things you can do on your
desktop or notebook Mac

Enjoy your sounds
The Music app can rip your CDs
S0 you can play them on your
Mac, or stream sounds from the Apple
Music service. But did you know you
can minimize its interface so it doesn't
getinthe way when you're working?
Click on the Window option in the top
bar and select Mini Player, or press
Opt+Cmd+M. You open a small window
showing what's currently playing and
giving you basic controls when you
hover over it. You can also enjoy a light
show that reacts to the sounds being
played. Again, click on the Window
% Menu and select Visualizer, or press
Cmd+T. It looks great in full-screen —
just the thing for a party. Visualizer
Settings are also available under the
Window menu.

AP Progress

Learnalanguage
Launched in 2012, Duolingo has
grown into the internet’s most

| popular means of learning a language. In

i fact, in the US, more people are learning

ndafin
minutes
Hauwss

Qihar Tmafiuntd

languages on Duolingo than in the entire Valyrian and Star Trek's Klingon. It's Wl s B P A
public school system. Duolingo offers accessible through a browser on the ; Wi Cile bs Dowrilcatiing. .
more than 100 total language courses for | Mac (www.duolingo.com), and there are Gussk Praterances
42 distinct languages. These include apps for the iPad and iPhone forlearning | PSSR,
endangered languages such as Hawaiian, : onthe move. Language students should | Bbixt Amgshart

| Navajo, and Scottish Gaelic, and fictional | also have https://translate.google.com ! Pedinct &

| tongues suchas Game Of Thrones' High bookmarked, a great translation site. = it i phimt e

L) 2 61N

Keep awake

Installa VPN

= Windsc ribeu Amphetamine is an excellent

Online security is increasingly R @ free app, available on the Mac

important these days. AVPN — Tirana App Store, that lets you stop your
Virtual Private Network — can do much S = .l computer from going to sleep. The app
to keep your data safe and protect your is accessed from the menu bar, and it
privacy. By disguising your location, it ek itz e can be activated and closed with a
can also get around geo-blocking Locations A single click. You can set your Mac to
restrictions. If a website is UK-only, for L =3 stay awake for a set time, while an app
example, just point your VPN ata E} I ¥% isrunning. while afile is downloading,
UK-based server. = and more.

-

Image rights: Duolingo Inc, Windscribe Ltd, Gimcastle Ltd, Apple Inc, William Gustafson.
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Artforfree

If you're looking for a powerful
e graphics editor but don't have
the money to spend on Photoshop, get
GIMP (GNU Image Manipulation
Program). It's open-source, free, and
available for most desktop/notebook
platforms. It has a steep learning curve,
but there’s plenty of online help.
Download from www.gimp.org.

BGLER SIT AMET

_.i.'u,l.luhllm
clomarrom wo, o rascana gyl samra
i ke

Free Office apps

Once a paid-for productivity suite,

Apple’s iWork apps are available for
free from the Mac App Store. These apps
comprise Pages, a feature-rich word
processor; Numbers, a powerful
spreadsheet application; and Keynote,
the presentation app used by Apple’s
speakers during their keynotes. Some
might be reluctant to use iWork apps as
they might need to share docs with other

Image rights: Apple Inc, The GIMP Team, Parallels Intl GmbH/Microsoft
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platforms, but much of the time this isn't
a problem. On Mac, click the File menuin
i the top bar, select Export To and choose
| acommon format such as a Microsoft
Office format, plain text or PDF. On
iPhone or iPad, tap the More button (*...")
then Export. You can edit your iWork
documents online at www.icloud.com,
and there are dedicated apps on Apple’s
mobile devices.

®i
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Sync Notes

Are you using the Notes app to

its fullest potential? As well as
making notes on your Mac and storing
them in folders, you can have them
sync with youriPad, iPhone, and the
iCloud website by placing them in the
iCloud section. You can also make a
Quick Note (also synced) by using the
Hot Corner in the bottom right.

Run Windows

While Boot Camp isn't available

on Macs that run Apple silicon
processors, it's still possible to run
Windows — as well as Linux, and other
versions of macOS — on your Mac. It's
called virtualization, and it lets you run
alternative operating systems
alongside macOS without rebooting.
Two leading Mac virtualization
solutions are Parallels Desktop
(www.parallels.com) and VMware
Fusion Pro (www.vmware.com). While
they're both very competent, Parallels
is more user-friendly, guiding you
through installs with a very easy-to-
use wizard. It's far more feature-rich
when used on Apple silicon Macs too.
Parallels Desktop Standard Edition
costs $99.99; Fusion Pro costs $199.

o
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Watch TV and movies
There's more to enjoying TV
o shows and movies than the
excellent Apple TV app. Most leading
streaming subscription services such as
Netflix, Disney Plus and Paramount Plus
have their own websites. If you access
them through Safari or another web
browser and log in with your account
details, you can enjoy their content on
your Mac. Download the free Plex media

Browse Reddit

Social news aggregation,

content rating and discussion
website Reddit (www.reddit.com) is a
wealth of info, but it can be messy to
use. The Apollo app (free, offers IAPs,
https://apolloapp.io) makes it a good
deal cleaner. Available on the Mac,
iPhone and iPad, it was coded by
a former Apple employee, and is
packed with features.

Store passwords
Password managers keep web
0 passwords, login details,
software serials, and more in the same
place. Several are available for the
Mac, but Secrets (free, offers IAPs,
www.outercorner.com) offers iCloud
syncing with its iPhone/iPad apps, a
password generator for creating
secure passwords, auto-fill, unlock
with Touch ID/Apple Watch, and more.

— e

Follow stocks
Previously only available on
mobile devices, the Stocks app

is now bundled with macOS too. The

app collates leading financial stories
and lets you follow the prices of
stocks. You can look up share prices
by a company name or its stock
exchange code, and then save them
so they appear at the top of the list.

P AL

center (www.plex.tv) and you can
stream all sorts of services directly to
your computer. If you have a NAS drive,
video files stored on it can be streamed
on Plex, or maybe the software bundled
with your chosen NAS drive. And if

you have video files that won't play on
your usual applications, try VLC (free,
www.videolan.org). It's ugly, but it can
handle pretty much anything.

Ty

Make music

Producing music on Mac doesn’t

have to cost a fortune. Sure, you
can use pro-level products like Logic Pro
($199.99, Mac App Store) or Ableton Live
(from $99, www.ableton.com), but
GarageBand is a free and fully equipped
music studio that's designed to be
accessible for beginners, but also
powerful enough to create quality

results. It comes with a sound library
featuring a range of instruments and
voice manipulation, so you can create
tracks with or without a physical
instrument. GarageBand also offers a
range of built-in lessons for piano and
guitar. You can share tunes on social
media, export them to Music, save them
as ringtones, and more.

Image rights: Apple Inc, Plex.
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Editamovie

Like GarageBand, iMovie is free,
@ available for Macs and mobile
devices, and combines ease of use with
some powerful features. If you're
interested in movie making, start here.
iMovie lets you create a cinema-quality
video (subject to your talents, of course)
including titles, transitions, and music.

made video templates, and create
exciting effects too.

When you're ready to move on to a full
professional video editing package, try
Apple’s Final Cut Pro ($299.99, Mac App
Store) or Adobe’s Premiere Pro ($20.99/
month). Although, there’s plenty to do in
iMovie before you've exhausted its

54 Genius Tips

Write a novel
You can use Apple Pages,
Microsoft Word, or the free Bean
word processor (Www.bean-osx.com)

|| You can design your work shot by shot
using iMovie's storyboards and pre-

potential. Movie making has never been
easier, or more fun.

for long-form writing. But if you're
serious about your novel, screenplay
or movie script, go for Scrivener (Mac

-

o

.'-. f,l

Vinfed
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Buy and sell
@ If you want to buy new and
second-hand goods at a bargain
price and sell your own unwanted items
for some spare cash, a number of
options are available. The most popular,
of course, is eBay (www.ebay.com).
There are two types of eBay sales; Buy It
Now, where you purchase or sell an item
for a set price, or Auction, whereby
buyers bid for items.

Image rights: Apple Inc, Vinted, Literature & Latte Ltd
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Vinted (www.vinted.com) works
differently to eBay, in that selling an
item doesn’t attract a fee, though paid-
for services are available. Vinted sales
are always fixed price — no auctions.
Finally, if you have a Facebook account,
try Facebook Marketplace. As it’s locally
based, you can arrange for items to be
collected instead of posted, and there
are fee-free options.

$59.99, www.literatureandlatte.com).
As well as your writing, it also
organizes your notes, makes it easy to
move chapters around, and lets you
store your research, all in one app.

If you have an idea but are unsure
where it fits in your project, just write
it, and slot it in later. You can write in
self-contained chapters and sub-
chapters, with each getting its own
file card where you can summarize its
contents for easy reference. By
allowing you to write, research, and
arrange documents into smaller
sections, Scrivener deals with
organizing your project, leaving you to
concentrate on the writing. When
you're done or ready to pass it on for
checking, you can exportitin a variety
of formats, including ebook. It's
available for the iPhone and iPad as
well as the Mac.

Another excellent long-form writing
app to try is Ulysses ($39.99/year,
www.ulysses.app). It's not as
powerful as Scrivener, but some might
prefer its more minimalistic approach.

MAY 2023 | 17
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On the iIPad

Tackle your creative projects on the go with
these perfectly portable apps and software

Reading Now : iPad ?S a
B drawing tablet
] } A neat trick for Apple Pencil
J ; ownersisto use theiriPad as a
KEN ' mh B drawing tablet for their Mac. It's easy
FOLLETT B Aol 5 to do. First of all, connect youriPad to
i C:r”io!\“ w your Mac using Sidecar. In macOS

L AR == : Ventura, do this by going to System
: Settings > Displays, click the “+" then
select youriPad from the list that
appears. In Monterey, go to System
Preferences > Displays, click Display
Settings, then select youriPad in the
Want to Read i sidebar. On earlier versions of macOS,
Sidecar has its own System
Preferences pane. With the iPad set up
as an extra Mac screen, clickonitin
Displays in System Preferences/
Settings. Under Use As, select “Mirror
for Built-in Display”. You can now open
the drawing app of your choice on your
Mac, and it also appears on your iPad

Read eBOOkS I (full-screen mode works best). Draw

The Pl ot e Rty Gwllows 1
B Cwlown Cruir Potemifn e
fy whige Brricuin

& Dewriazeg

My Collectigns

change the font and text size to suit your books onit. on your Mac.

1

' TheiPad is a very capable ebook eyes, and also tweak preferred display ! on the iPad's screen with Apple Pencil,
! G reader. It comes with its own options, like opting for white text on a * and the edits also appear on your Mac.
l ebook service in the Books app, where black background. Alternatively, on your iPad, you can
! you can buy and enjoy digital literature | If you've already bought ebooks from open the Control Center and tap

l (including some for free), and you can Amazon, you can read them oniPad I the Screen Mirroring icon. From the list
also read PDFs and books saved in | using the Kindle app (free, App Store). ! that appears, choose your computer.

' non-proprietary formats that you've This offers similar features to Books and, Your Mac now shows your iPad’s
installed outside the Apple ebook store. i when signed in with your Amazon screen. Choose any art app on the

I It makes for a comfortable read: you can account, you can access all your Kindle f iPad, and your drawing is also shown

i.

&

Image rights: Apple Inc.
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MINIMALIST
INTERIOR DESIGN

Handwritten
notes

If you own an Apple Pencil, try a
writing- and sketch-driven app
such as Noteshelf (§9.99), INKredible
(free, IAPS) or Inkflow Plus Visual
Notebook ($5.99); all on the App Store.
. And don't forget you can write using
ji the Apple Pencil almost anywhere on
iPad that you can type, including text
. fields, Notes, and Freeform.

Compose ascore

If Beethoven, Handel and Mozart

were alive today, they'd probably
compose their symphonies using an
iPad. With StaffPad, you can write
music with the Apple Pencil, and the
app transforms it into typeset notation

3D design

There are several apps for

3D drawing and design. Live
Home 3D is powerful and
affordable. AutoCAD mobile is
ideal for AutoCAD desktop users
who want to work on the go. Look
out too for Shapr 3D CAD modeling
and SketchUp; all are free on the
App Store but with IAPs.
Alternatively, Tinkercad is
completely free.

AN

A collaborative

whiteboard

With Apple’s new Freeform app,

you can visually lay out content
on a flexible canvas. Scribble notes,
draw diagrams, paste URLs, add
photos and more, and if you run out of
space, simply scroll the board to a clear
part. It's collaborative too — share it
with colleagues, and you can all work
on the same space, with edits synced.

that can be edited, played back, printed
and shared. Itincludes over 55
instruments, and you can buy more if
you wish. Itisn't cheap, though. The app
costs $89.99, with some of the
instrument packs costing $99.99 each.

Image rights: Apple Inc, Fluid Touch Pte Ltd, BeLight Software, StaffPad Ltd
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Video calls

Apple users have long enjoyed

FaceTime video calls, made over
the internet for free and available on
Macs, iPads, and iOS devices. Since i0S
15 and macOS Monterey, you can take
— but not initiate — FaceTime calls on
an Android or Windows device too. But
there's more to video calls and
conferencing than just FaceTime.

Skype is available for free from the

App Store, and it lets you make HD
video calls with up to 49 people at
once. Zoom (free, offers IAPS) is great
for conference calls, and is the
platform of choice for business users.
Facebook Messenger, another free
app. has a video calls service. Just tap
the video camera in the top-right
corner of the chat window. It's great
for chatting to Facebook friends.

o
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On the
IPhone

With an iPhone in your pocket,
you're never short of things to do

- Identify asong

{ If you hear a songonthe TV or
@ radio which you can'tidentify,

| usethe free Shazam app. Open it from

i theiPhone’s Home screen or Control

! Center, or simply say, “Hey Siri, what's

| this song?” The app identifies the tune,
and gives you other songs by the band,
lyrics and more. The app has an Apple

Watch component too.

Lewrl

Ly

Hang pictures
If you have trouble hanging your
pictures straight, reach for your
iPhone and open the Measure app. At
the foot of the screen, tap the Level
icon. Now place the side of your

iPhone on the top of the picture frame,
and adjust the picture until it's level.
You can also use this feature to make
sure twin hooks are parallel.

10:09

Wallet

wCash
CLIPPER.

uNITED T

$183.45

ADULT

Buy with Apple Pay
The days when you had to get
your wallet out and push your

credit or debit card into a machine are

gone. Now you can use the iPhone’s

Wallet app to store information on your

cards and, at the checkout, you can

wave your iPhone at the reader instead.

Better still, if you have an Apple Watch,
you can hold it next to the reader and
pay without reaching into your pocket.

To set up a card or cards with Apple
Pay, open the Wallet app, tap the “+"icon
and follow the on-screen instructions to
scan the card. Add the security code
from the back of the card if asked to do
s0, and your card is ready for Apple Pay.
To pay with your Apple Watch, double-
tap the side button and use the Digital
Crown to choose a card. It's quick, easy
and secure.

Shine alight!

You can use your iPhone as a

torch, using the camera flash to
shine a light. From the Lock Screen,
deep-press the icon on the bottom
left, or open the Control Center and
tap the Torch icon there. Or you can
say, “Hey Siri, turn on my torch”.
Long-press the Control Center Torch
icon to set its brightness. Take your
iPhone with you, and you'll always
have a torch handy.

Image rights: Apple Inc.
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Emergency location
What3Words is a free app that orinjured, you can use the app to get
everyone should use. It divides the your three words, and pass them on to SHARPEN CUEVES * SHADOWS
world into three-meter (9.8ft) squares the emergency services, who can use
~ and gives each square a unique them to find you — even if you've run into RAW (B = & .f% -h_

combination of three words. If you're lost difficulty at sea.

Upgrade your
Maps photography

The iPhone's Camera appis an

@ everyman's tool, designed to be
Parked Car simple to use and accessible. If you

. - sy want greater control over your
smartphone photography, you need a
third-party app. Luckily, there are
plenty to choose from. Camera+ (free,
IAPs) gives an excellent range of
camera settings, and lets you shoot in
Raw too. Its main competitor is
ProCamera ($13.99), which has great
low-light capabilities as well as
Parked Car an excellent feature set.

Halide Mark Il (free, IAPs) offers a 5
. range of features, ProRAW
Flnd your car compatibility and is perfect for
Do you forget where you you're ready to return to your car, hardcore photographers. If you're keen

@ parked your car? Siri can help. open Siri again and say, “Where am on long-exposure pics, try Slow
After parking, open Siri and say, | parked?”, and you'll see the Maps app Shutter Cam ($1.99); though it’s likely
“Save my parking spot”. Siri then open again, and provide directions to to augment rather than replace your
remembers where you parked. When your parking spot. main camera app.

30-98 Unio

[ ]
Image rights: Apple Inc, what3words Ltd, cocologics. .’ - MAY 2023 21
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Scan documents

You can use your iPhone to scan
@ adocument directly into the
Notes app. Open a note (new or
otherwise) and tap the Cameraicon for "
amenu. Tap Scan Documents, then
hold your phone over the document.
Tap the shutter button to scan, then
drag the corners of the document to
adjust it. Tap Keep Scan to save.
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Calculations

The Calculator app does more

than you think. Turn it sideways
and it becomes a scientific calculator.
Touch and hold a calculation result and
you can copy and paste it into another
app. and swipe a figure left or right to
delete the last digit. If you need a %
calculator with even more power, L
try the PCalc app ($9.99).

B A
One-handed typing

If you want to keep a hand free

while using your iPhone, you can
switch to a one-handed keyboard by @
going to Settings > General > :
Keyboards and choosing One-Handed
Keyboard there. Alternatively, tap and
hold the globe icon under the keyboard
and select it there. It can be set to sit
on the right or the left side.

Find movie theater
times and prices

If you're a big-screen film fan,

check out free apps like
Fandango, Atom or Flixster. They're
great for seeing what's on near you,
finding where a specific movie is
showing in your locale, buying tickets
and more. Check whether your local
theater has its own iPhone app too. If
it's part of a chain, it probably will.

keyboard Settings...

English (US) Add your signature

To sign a document on your
@ iPhone, scan it into the Notes
app (see #34 above), tap the Share
icon, then choose Markup. Next, press

Book a hotel

There are several free apps that
let you book a hotel visit from
your iPhone. Booking.com enables you

English {Canada)

English (Australia)

A 2:F MAY 2028 s

to search through 27 million venues,
and filter by price, amenities and more.
Travel fare aggregator Orbitz offers car
rentals as well as travel, and also look
out for Travelocity, Priceline, Hotwire,
and Kayak.

b\

Emaoji

the “+"iconin the toolbar at the foot of
the screen for more options. Tap
Signature, and then select a saved
signature or add a new one. Finally,
drag it to the correct place to sign the
document with your signature.

Image rights: Apple Inc, Booking.com, Orbitz LLC, Wanderu Inc.
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Gig alerts

If you like live music,
@ comedy and theater,
download Songkick Concerts. You

can track your favorite artists and
get a notification as soon as they

announce tour dates nearby. You

can even buy tickets from the
app. Look out too for DICE,
Ticketmaster (which covers
sports and theater as well as
music), and Bandsintown.

' Remote controls

| If you keep losing your TV

i @ remotes down the back of

the couch, there's an alternative
in your pocket. Go to Settings >
Control Center and add Apple TV
Remote to access a remote
controller for Apple TV from the

: Control Center. There are remote

! apps for Kodi, Roku, Samsung TVs

! and more, and several for
universal remotes.

Boston to New York

Gd PETER PAN

9:45 AM

South Station Bus T

Detalls

Q GREYHOUND

11:00 AM

yuth Station Bus T

115 AM

Port Authority

eticket

3:15 PM

Port Authority

Look up train times

There are a number of

apps that let you check
your train times on your
iPhone, and buy tickets too.
The Amtrak app gives train
status, station information
and more, and lets you buy

Detaills

etickets directly from your
phone. MTA TrainTime covers
the Long Island Rail Road and
Metro-North Railroad,
Wanderu covers buses as well
as trains, and there are
numerous local rail apps.

eticket
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Your banking

Does your bank offer an
@ i0OS app? Most do.
Obviously their features depend
on the app in question, but with
abanking app. you're likely to be
able to check your balances,
move money from one account
to another, pay off your credit
card, and even use the iPhone’s
camera to pay in a check. No
need to take a trip to the bank.

Fahrbahnschaden

Translate

GErman

Fahrbahnschaden

Engish [LE)

Road da

Translate notices

You can use your Camera app to

translate foreign text on notices,
menus, leaflets and more. Point the
camera at the text, and when the
yellow frame appears on it, tap the Live
Text icon (horizontal lines within a
square). Select the text to translate,
then tap Translate (if you don't see the
Translate option, tap the chevron).

Use emergency SOS
@ To contact the emergency
services on your iPhone,
you need to press and hold a Volume
button and the Side button at the
same time. You can then swipe the
slider marked Emergency Call to
contact the emergency services in
your locale. Alternatively, you can click
the Side button five times to get to the
same screen.
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On the

& Watch

Look what you can do with the world’s
best-selling smart watch on your wrist

Record voice memos
Torecord a short voice
memo on your Apple Watch,
open the Voice Memos app and tap
the red button. It turns into a square
as the app records. Tap the square
to stop recording. The recordings
appear on the Voice Memos app
on your iPhone, where they can be
reviewed, deleted, enhanced,
shared and more.

<{ Austin-St. L... 10:40

3

= (2:3) @

HIGHLIGHTS

Maximiliano Urruti
for Gyasi Zardes

88' Austin
Joshua Yaro

. Keep score
{ If you like soccer, download the
OneFootball app (free, IAPs). It

lets you follow your favorite club

i teams from numerous American and

i foreign leagues, international teams,

i and get notifications on your Watch.

i Setitupand you're told when a match

{ startsand ends, agoalis scored, a
player gets cautioned, and more.

AN

>

Countdown timers
Apple Watch offers a great
countdown timer which can

track time for up to 24 hours. Open

the app. and standard timers such
as one minute, three minutes, five
minutes, and so on are offered. Tap

Custom to set a timer for any time

you like. Alternatively, use Siri — say,

i “Seta timer for [x] minutes,” and

. the timer starts.
N
¢ Lisinopril 17:14
- - - l
Lisinopril
Tablet, 10 mg
1tablet

Amount taken

17:14
Time taken

Sort your meds

Arecent addition to the Watch is

the Medications app. With it you
can set reminders for when you need
to take your meds, log your
medications after you've taken them,
and set up warnings should two
medicines you're taking react badly to
each other. You can add vitamins and
other self-chosen medications too.

1:46

27 sec

Note: Apple Watch
never checks for heart
attacks.

Doan ECG

Keep track of your heart's

health with the built-in ECG
(electrocardiogram) app. Open the
app. and keep your finger on the
Digital Crown for 30 seconds. You get
a heart reading, including beats per
minute and whether your reading
shows signs of atrial fibrillation. This
reading is then stored in your
iPhone’s Health app.

Protect your hearing
The Noise app measures the
volume of the background noise

and lets you know if it's loud enough to

harm your hearing. Open the app and
you're shown the current sound
volume. In Settings > Noise on your

Apple Watch you can set how loud it

has to be before you get a notification,

or turn off notifications altogether.

Noise 2:07

54 .

® oK

Long-term exposure to

sounds at this level
should not affect your
hearing

Image rights: Apple Inc, OneFootball GmbH.
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Blood Q, 4:02

10sec

Blood oxygen

Another health benefit of the

Apple Watch is the Blood
Oxygen app. With your wrist flat and
the Apple Watch facing up, tap Start.
Hold your arm steady for 15 seconds
while the test is run, and you receive
the results. Tap the “i” in the results
window for info on blood oxygen
levels. Results are stored in Health.

-, "-"‘. h 21:41

3:48
~-1nd Devi
lan's Apple
Watch
With You
Now =)

lan Oshorne's @
iPad Pro

Newton Abbot, England

Find your devices
The Find My app is available on
@ all key Apple devices, including
the Watch. It allows you to find lost or
stolen Apple gear, showing their

location on a map. You can make your
misplaced device play a sound, receive
a notice if you've left something
behind, and mark a device as lost if
you've given up hope of recovering it.

< Alison 16:15

No thanks, too =

Work out

The range of different workouts

on the Apple Watch is growing
all the time. Open the app and scroll
through them with the Digital Crown

to take a look. Scroll all the way down
and tap Add Workout to add more to
the list. The three-dots icon (“...") in the
top left of every workout lets you
customize your exercise to suit.

Image rights: Apple Inc

Read Saturday

Yes please, |

haven't read it

A

Send & receive

messages

Messages is an excellent
extension of the iPhone app.

You can reply to incoming texts or
| sendanew one, review
| conversations and send prewritten

replies with the tap of a button.

Other messaging apps that offer a
| Watch component are WhatsApp,
WatchChat 2, Spark, and Telegram.

54 Genius Tips
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You Know I'm No Gt 4,
Amy Winehouse—E

“ @) »
@

Control Music
andTV

@ The app that looks like a play
icon on a blue background is for

Apple Remote. Pair the app with your
Apple TV (third gen or older) and/or
your Music library, and control your
viewing or sounds from your wrist. The
remotes aren't as comprehensive as
the regular controls, but very handy.

{ Tomorrow 16:09
-
“? A
4 Y A

= 06:37
& 19:39

World time

You can add cities to your World

Clock app directly from the
Watch. Scroll the list up and
tap Add City. Choose a city for more
local-time information. If you want to
set your Watch to a different time zone
to your iPhone, open the Watch app
and go to My Watch > General >
Language & Region.

o
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HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD

Collaborate with Freeform

Freeform is the ideal tool for brainstorming with colleagues remotely

REQUIRES APPLE HAS BEEN adding see how Freeform could quickly become very
macO08S 13.1 or later, collaboration and sharing popular, particularly among creative teams
i0S 16.2 or later \ features to macOS, iOS and who work remotely.
iPadOS for several years now, Here we take a look at how to get started
YOU WILL LEARN allowing you to work with others in with Freeform’s collaborative features, and
How to use collaboration applications like Pages, Numbers, and even the ease in which you can share your work
features in Freeform Notes. But it’s in a new Apple app, with others. KENNY HEMPHILL
and beyond Freeform, where some of the
most interesting opportunities
IT WILL TAKE to collaborate lie.
30 minutes In some ways, it’s a surprise

that Apple, a company whose
roots are in making products for
creative professionals, took as
long as it has to release software
that provides tools to help
kickstart the creative process,
essentially creating the digital
equivalent of a meeting room
and a whiteboard. However,
now that it’s here, it’s easy to -

HOW TO Get started in Freeform
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Set up collaboration Finish iCloud setup Manage sharing

To start collaborating, you need If you have already used To edit sharing settings, Ctrl-
to turn oniCloud in Freeform. Launch Freeform on an iPad or iPhone and have click on the board and choose Manage
Freeform on your Mac, click Shared in created boards, it will now ask if you Shared Board. In the window that opens,
the sidebar, then click “Go to Settings”. want to merge your Mac-based click the “+" button to share with more
In Settings, click iCloud, scroll to Freeform data with your iCloud Freeform people and use the options to control
Freeform and switch it on. data. To do that, click Merge. how the board can be edited.

28 MAY 2023 Image rights: Apple Inc



How to do anything on your Mac, iPhone & iPad

HOW TO Team up using Messages

- e .
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Share in Messages

If you use Messages to
collaborate on a Freeform document,
you can see updates in Messages when
someone makes changes. Open the
Freeform board you want to share, click
the Share icon and choose Messages.

Pick collaborators

When Messages opens, you'll
see a new message with a link to the
Freeform board. Start typing the name
of the person you want to collaborate
with in the Send field. Choose a contact
from the list that appears.

HOW TO Go deeper with collaboration

2023 Vacation ldeas ~ ———

iy

0 B

See others’ work

In a board you're collaborating
on, click the head-and-shoulders icon
to see collaborators. Check Participant
Cursors. You'll see the additions they
make. Participants can only undo and
redo their own changes.

Image rights: Apple Inc.

Add more people

Click the head-and-shoulders
icon on the board to add people and
choose Manage Shared Board. Click
Share With More People. Choose a

suggested person or click on an
application to share the board.

Set the parameters
You can add collaborators
by adding more names in the Send
field. Next, click the text below the
thumbnail of the board and choose
how you want to share the board and
the permissions for participants.

[T — 1 a

oo
-
=

Remove
collaborators
In the Manage Shared Board dialog,
hover the pointer over a name, click “.”
and choose Remove Access. To stop
sharing a board altogether, click Stop
Sharing at the bottom of the box.

> WORK TOGETHER IN OTHER APPS

Sharing files with others made simple

Pages, Numbers, and Keynote all enable you to share documents with others and
collaborate with them. Those you allow to do so can make changes to documents or
add comments, and you can see those changes summarized the next time you open
a document. Notes also now lets you collaborate the same way. All these apps use a
Share menu to start the collaboration; you just choose how you want to collaborate
and who with and they will be sent a link, with participants’ edits being updated to the
document in real time. Photos goes even further, enabling you to create a shared

library with friends and family.
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Use Notion to help organize both work and play activities

REQUIRES
Notion (free, with IAPs),

TIRED OF TRYING to manage your
work and personal projects in

drag and drop items, create databases and

mac0S 10.12 or later

YOU WILL LEARN
How to create and
manage pages and
databases in Notion

IT WILL TAKE
15 minutes

a multitude of different apps?

Instead of juggling the likes of
Dropbox, Airtable and Trello, try Notion. It
can handle anything you throw at it, from
simple text documents to sprawling
databases with countless contributors, and
is super—simple to use no matter what you
want to do.

Notion’s key strength is its ease of use. It

comes with a friendly interface that lets you

HOW TO Manage your tasks with Notion

tables with just a click, and collaborate using
tags and comments. That means you can
plan your next holiday or keep track of your
work assignments without a steep learning
curve or having to switch apps.

Despite its extensive feature set, Notion
is totally free to use. You can pay for some
extra tools like more space for uploads and
extra guest slots, but for most people that’s
not necessary. Getting all its best features
for free is the cherry on top. ALEX BLAKE

My first page
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Create a new page
Click New Page and add a title. If
you just want to get started, press Return.
Otherwise, pick a template and click
“Get template” to add it. You can also
import CSV and HTML files or content from
third-party apps.

30 | MAY 2023

Click and drag
Start a new blank doc and begin
typing. Click and drag the dotted lines

to move a content block around. Press “+"

to the left of the dotted lines to choose
what type of content to add, including
lists, headers, sub pages, and more.

Convert a block

Ctri-click a block and hover the
pointer over “Turn into”. You will see a huge
list of options. This lets you quickly
transform plain text into a checklist, for
example, or switch from a one-column
layout to a five-column one.

Image rights: Notion Labs, Inc.
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Page organization

You can add page icons and
header images, and rearrange your pages
in the sidebar. To add a sub page, click “+"
next to the page name in the sidebar. You
can embed or link to other pages and
databases within each page.

Card details

Hover over an entry and click Open.
This displays each entry’s details, where
you can add comments, attach files,
assign colleagues, and more. Try
adding a comment, or click “Add a
property” and choose from the list.

¥ Waork planner
Tl N Tk ks
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Show more info

By default, all properties except
the item name are hidden. Next to the blue
New button, click “." followed by
Properties. Now drag anything you
want shown to “Shown in board” and
you'll see it without clicking the task.

Image rights: Notion Labs, Inc.

How to do anything on your Mac, iPhone & iPad

New database

Databases are collections of pages,
and can be organized in various ways.
Click “New page”, then Table (under
Database). Under “Select data source”,
click “New database”. We'll convert this
into a project management board.

Display options

Under your table’s title, click “+"
next to the word Table. Now choose a new
view for the content. Board lets you drag
and drop items between categories, while
Calendar might be helpful if you've
assigned due dates.

Add a filter

Click Filter and you can choose
from basic or advanced filters. A simple
date filter can highlight any items that fall
between two dates. An advanced filter can
use multiple criteria to find items, which
helps in larger datasets.

M Work planner
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Add some entries

Start by adding some data. We'll
use this to manage our work, so under
Name, add some tasks you need to do.
Add some tags, then click “+" in the third
column and pick Date from the list, before
adding some due dates.

Board view

Click Board from the view list.
Under “View name”, type “Task status”.
Click and drag the columns to reorder
them, if you like. Now you can quickly
switch between views when required,
or add another view if it suits.

The search tool

Lost something? Notion has a
powerful search feature that can help.
Simply press Cmd+P and start typing. You
can adjust search filters on the fly and
results will start populating every time
a letter is added.
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Have we reached
“peak iPhone"?

CHARLOTTE HENRY explores whether Apple's key product

is starting to lose its magic
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Edit your PDFs with ease

Adjust, sign and annotate PDFs with PDF Expert

REQUIRES
PDF Expert ($79.99/year),
mac0S 10.13 or later

YOU WILL LEARN
How to adjust your

PDFs with a host of tools
in PDF Expert

IT WILL TAKE
10 minutes

WHETHER WE LIKE it or not, most
) of us regularly work with PDFs.
Editing these files can be
unwieldy, provoking more
frustration than anything — unless you
have PDF Expert at your disposal. This app
has an array of tools designed to help make
managing your PDFs much easier. You
can edit text, fill out forms and sign
documents, banish blotches and unwanted
imperfections, and rearrange pages with
a quick click and a swipe.

HOW TO Work with PDFs in PDF Expert

There are various reading modes
(including Split View) designed to ease the
burden on your eyes, while you can export
to different formats to share with others.
And if you have an iPad, you can annotate
your files with handwritten notes and
signatures with the help of an Apple Pencil.

So instead of struggling along with the
limited PDF tools in other apps, you may
find that PDF Expert makes things a whole
lot more bearable. It’s an incredibly useful
app to have by your side. ALEX BLAKE
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Sign documents
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Fill out forms

Annotate your files

Click the Annotate tab > My
Signatures, then click the “+" button to
sign a file. Add a signature by typing, using
a trackpad, or adding an image, then click
Create. Drag it onto a document and resize
if necessary.

PDF Expert recognizes forms,
including checkboxes and drop-down
menus. In a form, click inside a box
(highlighted in purple) and start typing.
If there are no interactive purple boxes,
click Annotate > Text to add text.

In the Annotate tab, the top row
of buttons has various annotation tools.
Some, like the highlighter and underliner,
automatically snap to lines of text. You can
add stamps, sticky notes, shapes, and
more to your file.

32 | MAY 2023
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Edit text
Click the Edit tab, then select Link.
After highlighting some text, you can add
a URL. Or, click the Redact button and
highlight text to black it out or erase it.
Finally, you can click Text to change
the words on the page.

Work with images

Click the Image button, then select
an image on the page. In the right-hand
sidebar, you can rotate the picture, crop it,
replace it, or export it. To add a new
picture, click Edit > Image, then click
anywhere on the page.

Recognize text

If you need to make text in an
image selectable, click Scan & OCR >
Recognize Text. Choose your language and
click Recognize, decide how many pages
to scan, then click Apply. You can now
select the text in the PDF.

Image rights: Readdle Limited.
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B Change the font

If text is too small, click Edit > Text,
highlight the text in question, then
increase the font size in the right-hand
sidebar. You can also change the font,
weight, color, and alignment to make

it easier to read.
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Enhance your scans

Sometimes, scanned documents
don't look their best. To fix things up, click
Scan & OCR > Enhance Scan. Here, you
can convert the scan to color or black and
white, remove distortion effects and
blemishes, and more.

Split, merge, crop

Got two pages side by side? Click
Scan & OCR > Split Pages to separate
them. Or click File > Merge Files to combine
two or more PDFs. You can also cut out
distractions like page gutters with Scan &
OCR > Crop Pages.
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o Choose a theme

PDF Expert has a few themes to
make viewing easier. Click View > Themes
and choose either Day, Sepia, or Night.
Each theme’s colors also affect the

content you're viewing, so a white
page turns black in Night mode.
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Clear margins

If you have a scanned page and
want to clear the sides for notes, click
Scan & OCR > Clear Margins. You can drag
the margins to set how much space is
cleared and choose the margin color. Then
click Clear Margins > Apply.

Reorder pages

You can rearrange pages by
clicking the Page Thumbnails button in the
top left, then clicking and dragging a page
to reorder it. This menu also lets you
rotate, copy or extract pages and append
fresh pages to the file.
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How to use Continuity Camera

Why buy a separate webcam when you can use your iPhone?

REQUIRES

macO0S 13 or later, i0S 16 or
later (some features require
a recent iPhone)

YOU WILL LEARN
How to use
Continuity Camera

IT WILL TAKE
30 minutes

e
-

GENIUS TIP

If you tap Disconnect on the
iPhone screen, you will have
to connect it to your Mac
with a cable to use it as

a webcam again.

34 | MAY 2023

APPLE'S CONTINUITY SUITE
of features has been around
for years. It’s this feature set that
~" enables you to use your iPhone
as a scanner for your Mac, for example. The
latest addition to the suite, Continuity
Camera (confusingly, it has the same name
as the scanning and photo features), enables
you to use your iPhone as a higher quality
webcam for your Mac when making
FaceTime, Zoom or Teams calls. In fact, you
can use this feature with any application
that would normally use the FaceTime
camera on your Mac.

Using your iPhone in this way not only
gives you more flexibility in where to
position the camera, but allows you to make
use of some of the features of recent iPhone
cameras. For example, more recent iPhone
lens systems work much better in lower
light than the FaceTime camera on a Mac.

READY FOR YOUR CLOSE-UP

More impressively, Desk View makes use of
the Ultra Wide setting on the iPhone 11 and
later to allow you to show a top—down view
of your desk and your face at the same time.

You can use Portrait mode to blur the
background or Studio mode to dim it while
lighting your face. And Center Stage keeps
you in the middle of the frame when you
move around.

You can choose whether or not to use your
iPhone’s microphone for calls, and if you do,
you can isolate your voice from ambient
noise or do the opposite and capture all the
noise around you as well as your voice.

KENNY HEMPHILL
__p—‘:"_,.-.'-ﬂp-'
1 (‘
|
@

Belkin's $29.95 iPhone Mount with MagSafe is one of several
gadgets that enables you to use the MagSafe magnet
to mount your iPhone on your Mac.

Image rights: Apple Inc, Belkin
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HOW TO Use your iPhone as a webcam

giffgali

o Get your

iPhone ready

Your iPhone needs to be close to your
Mac in order to use Continuity Camera.
It also needs to be locked. You can

charge it from a plug or from your
Mac while using it.

h -

Use Center Stage

To have your iPhone place you at
the center of the screen, click on Control
Center, choose Video Effects then
Center Stage. Note though, that to use
Center Stage you must have an iPhone
11 or later, excluding the iPhone SE.

- W

o Try FaceTime
Desk View

Start the call then click Desk View in the

top right of the window. Use the Zoom

control to zoom in or out. Click Start

Desk View. If your desktop can't be seen,

click Desk View then Share Desk View.

Image rights: Apple Inc, Belkin.
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Mount your phone

If you're using a mount, connect
it and attach it to your Mac. If not,
position your iPhone where it is stable
and facing you. If you put the iPhone in
landscape mode, most apps will be able
to choose your iPhone automatically.

Use Portrait mode

Portrait mode, which blurs the
background, needs an iPhone XR or
later. Click on Control Center, choose
Video Effects then select Portrait. You
should see an effect similar to using
Portrait mode to take photos.

Desk View

across apps
If you're using another video calling app
such as Zoom or Teams, start the call
and click Control Center, then click Desk
View. Go to the screen sharing controls
in the app and choose Desk View.

Choose the camera

Launch FaceTime. If it does not
choose your iPhone’s camera
automatically, click the Video menu and
select it. Most third-party apps should
also choose it automatically. If not, use
the device settings in the app.

Turn on

Studio Light
Studio Light illuminates your face and
dims the background, useful for when
you're sitting in front of a window. Go to
Control Center and then choose Video
Effects > Studio Light.

Change mic modes

There are two microphone
modes. Voice Isolation prioritizes your
voice and minimizes background noises
such as traffic. Wide Spectrum captures
everything. Click Control Center then
Mic Mode to choose one.
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Master iPhone video controls

How to use different shooting modes and file formats in the Camera app

REQUIRES
An iPhone (some features
model-specific)

YOU WILL LEARN
How to master different
video shooting modes
and formats

IT WILL TAKE
15 minutes

WITH THE INTRODUCTION of the
iPhone 14 you can now shoot
smooth, steadier videos in Action
mode, but that’s not the only
type of video your iPhone can capture. In
this tutorial, we’re going to explore all of the
video recording modes available to your
iPhone’s camera, explaining what they are,
how they work, and how you can make the
most of them.
We’ll be covering Action mode, shooting
in HD, 4K, and the amazing Cinematic
mode. Plus, we’ll take a look at options such

as Slo-Mo, Time-Lapse, and Live Photo to
expand your video shooting repertoire.
You’ll also discover how to turn on the
Apple ProRes format on Pro model iPhones.
ProRes enables you to capture HDR (High
Dynamic Range) clips that have a wider
range of colors and tones than standard
HD or 4K. HDR clips take up a huge amount
of storage space, so we’d only recommend
shooting in Apple ProRes if you need to
edit and share clips to be viewed on HDR-
compatible devices such as an iPhone 14 Pro.
GEORGE CAIRNS

QUICK LOOK Make the most of your camera’s capabilities

APPLE PRORES

On a Pro model iPhone tap here to
toggle on the ProRes shooting mode
(once you've activated it in Settings).

36 | MAY 2023
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2: 68 min

SHOOTING TIME

A minute of 10-bit ProRes HD footage
takes up 1.7GB of storage space.
Maximum shooting time appears here.

SELECT A MODE

In the Camera app, swipe here to
choose a shooting mode. The active
mode will appear in yellow.

FRAME RATE

Tap here to change the resolution and
frame rate. We're shooting at 4K res
with a frame rate of 30fps.

Image rights: Apple.
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HOW TO Utilize every video mode
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Specify file formats

Go to Settings > Camera. Here
you can choose default video file sizes
and frame rates for the Camera app.
such as shooting 4K footage at 30fps.
You can also change file sizes and
frames rates from within the app.

Pull focus

While shooting in Cinematic
mode, the camera will usually focus on
the person closest to the lens. You can
tap on a background person (or object)
to make them become sharp. A yellow
box indicates the focal point.

Action stations
The iPhone 12 and 13's sensor-
shift optical image stabilization system
reduces camera shake. When shooting
video on the iPhone 14 range, tap the
Action mode icon to capture even
smoother handheld clips (up to 2.8K).

Image rights: Apple.

HD or 4K

In the Camera app. swipe to
Video mode. Tap top-left to toggle the
resolution between HD and 4K. Tap to
change the frame rate. 30fps is good
for sharing HD files online; 24fps gives
a more cinematic look on a 4K TV.

r .

Shoot slow-motion
Swipe to Slo-Mo. Tap top-left
to shoot at 720P with a slow frame
rate of 240fps to create a small (low-
resolution) file. For higher quality
choose HD 120. Tap the red button
to record a slow-motion clip.

¢ M Lomioe - Zail e
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Live Photo

Live Photo mode captures a
short video sequence that you can use
in creative ways. In Photos, tap the top-
left menu and choose Long Exposure.
Moving objects become blurred (as if
you'd shot using a slow shutter speed).

Cinematic mode

To give your footage a Hollywood
look, swipe to Cinematic mode. This
mode is similar to the Portrait mode
in that it digitally blurs the video clip's
background while keeping the main
subject looking nice and sharp.

Time travel

To view the world in a creative
and dynamic way, swipe to Time-Lapse
mode. This causes the iPhone to
capture approximately two frames per
second. When you play the clip, subjects
such as clouds move at high speed.

Srke Prsfies a

Enable ProRes

On Pro iPhones, go to Settings >
Camera > Formats. In the Video Capture
section choose Apple ProRes. In the
Camera app, tap to turn ProRes on or
off. You can edit ProRes clips in iMovie
on iPhone to preserve their HDR quality.
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“fastodon

Social networking
that s not for sale.

Get started

with Mastodon

REQUIRES
A browser, and a
bit of patience

YOU WILL LEARN
What Mastodon is and
how to use it

IT WILL TAKE
20 minutes

MASTODON HAS BEEN a big
beneficiary of Elon Musk’s
Twitter takeover; with the social
media site in apparent chaos and
lots of previously banned users being
allowed back on, many people have been
looking for a more pleasant alternative. And
for many, Mastodon is that alternative. It
has very strong anti—abuse rules, and with a
bit of effort you can make it just as easy to
use as Twitter.
It works a bit like email; in much the same
way you can have yourname@iCloud.com or

Set yourself up on Mastodon

Servers

( }.1- Find your place
% Head to https://joinmastodon.org

‘masindan

L} Open an account

The Servers tab will show one of

yourname@gmail.com, there are different
Mastodon servers for different people.
Mastodon calls them “instances”, and there
are instances for journalists, drummers,
environmentalists... and so on. You can see
posts from and communicate with people
from other instances, just like you can
email Gmail users from your iCloud mail.

In this tutorial, we’ll discover how to get
started, and how to find out and follow other
people. We’ll focus on the desktop here, but
there are great iOS apps available too.
CARRIE MARSHALL

i 1._} Read the rules

Every instance has its own set of

and click on Servers. This enables you to
see a list of available servers and to sort
them. For example, you can find instances
dedicated to football or tech, or to specific
cities or countries.
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two buttons below a server name: Create
Account or Apply For An Account. The
former means anybody can join; the latter
means the server vets new users to ensure
theyre not a potential problem.

rules, and breaking them can get you
banned from that instance. These rules, for
the mastodon.london instance, are fairly
typical and hardly controversial: nothing
illegal, no hate speech, etc.



Enter your details

All you need to do now is sign
up with the instance by providing your
name, preferred username and email
address. You're signing up with a specific
instance, not an app; you can use any
app you like to access your account.
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Look at Local

There are three views of Mastodon.
The standard view is your own feed, which
will contain posts from the people you
follow. The Local view shows posts
published in the instance you're on, in this
case mastodon.london.
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Pick your account

You have two choices here; you
can log in with an existing Mastodon
account, or you can create a new one. We'll
use the Mastodon account we just set up,
so we'll enter the name of our chosen
instance in the field provided.

Image rights: Apple Inc, Mastodon gGmbH, Bruno Philipe.
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Check your spam

Strangely, Mastodon confirmation
emails often go straight to spam or junk. If
you don't see an email verification link, it's
probably been marked wrongly as spam.
Find the message and click the link to
activate your account.
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Look around

This is the web interface for
Mastodon, and it has three columns. On
the left is where you write your posts and
replies. In the middle is where you see
other posts, and at the right there are the
various options to filter what you see.

Join the federation
The other view is the Federated
view. This enables you to see posts
from other Mastodon instances that
your particular instance is federated
with — many will be from people that other
users on your server follow.
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Authorize your app

Whether you're on Mac, iPad or
iPhone, the app needs to be authorized
before it can connect to your account. You
should automatically see the screen
shown here, and clicking Authorize takes
you back to the app.

Install an app

There are some good third-party
apps for Mastodon for both desktop and
i0S, and many of them are free. Although
they may look different, they all work in
much the same way. Let's try the free
Mastonaut app (https:/mastonaut.app).
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Find your people

You can also see which of your
Twitter follows have Mastodon accounts.
https:/movetodon.org can scan your
Twitter account, enabling you to follow
some or all of the people who've got
Mastodon links in their profiles.
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Connect external devices

You can connect your iPad to almost anything via the power of USB-C

REQUIRES
iPad, USB-C cables
or adaptors

YOU WILL LEARN
How to use external storage
and other devices with iPad

IT WILL TAKE
10 minutes

=

GENIUS TIP
Your USB-C iPad can charge

your iPhone, AirPods or
Apple Watch.
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P = » ONE OF OUR favorite things about
| the latest iPads is their USB-C
" port, which enables you to
connect all kinds of devices.
USB-C is the most recent and fastest
version of the standard, and it enables you
to connect more demanding devices such as
fast external storage. It also lets you charge

your iPhone, AirPods, or Apple Watch; just
connect the appropriate cable to your iPad

If you're into making music, USB-C enables you to connect
external keyboards so you can play around in GarageBand.

and it’ll share its battery. Your iPad can also
move files to and from external drives and
memory cards; connect to DisplayPort
external displays; work with keyboards and
mice; connect to USB interfaces for
microphones and musical instruments; and
you can use it with adapters as an HDMI
output or an Ethernet connector.

With the iPad Pro 11-inch (3rd gen) and
the iPad Pro 12.9-inch (5th gen), you can
daisy—chain devices to connect multiple
Thunderbolt accessories simultaneously.

SOME LIMITS APPLY

There are some limits to what you can

do, however. USB webcams won’t work in
FaceTime, and while you can connect to
external storage you can’t format or
partition it and it has to be formatted as
FAT, FAT32, exFAT, or APFS. And some USB
devices need more power than your iPad can
provide, so for those you’ll need to connect
your iPad to a mains—powered USB hub.
CARRIE MARSHALL



How to do anything on your Mac, iPhone & iPad

HOW TO Expand your storage with an external drive &

JARGON BUSTER

T S mow
-
Open up Files

When you connect a USB external drive
or memory card, it'll show up in the Locations
section of the Files app’s sidebar. Some devices
may need external power — if so, they won't show
up until theyre connected to power.

AW

Have a listen

One of the great things about USB-C is
that it's very fast, and that means you don't need
to copy media files from external storage to your
iPad in order to play them. Here were checking
out a high-quality Apple Music track.

View your videos

Provided they're in a format your iPad can
play, you can even view videos in real time from
your external storage — and, as you can see at
the top and bottom of the screen here, you can
instantly rotate the clip or scrub through it.

Image rights: Apple Inc

e 2 Thunderbolt was a faster
alternative to USB, but the
most recent versions of

= USB have caught up. The

— —~ . . iPad Pro's USB-C/USB 4 port

: is also a Thunderbolt 4 port.

ey

Explore your documents

As you can see, external storage works
just like your iPad storage — and you can drag
and drop between the two. You can't format
external storage from your iPad, though; for that
you'll need to connect it to your Mac.

" Iy _fiinl'.k

wrrmmn ||

s
ey

Get marking

Everything on external storage works as it
would if the files were stored on your iPad, so for
example you can open an image and use Markup
to highlight or annotate it, or use the Share menu
to send it via Messages or Mail.

TWise

-

GENIUS TIP

You don't need the most

e recent iPad to connect
devices such as USB
keyboards or audio
interfaces to your

A 6 Apply actions tablet, but you will
Press and hold on a file or folder in the need a Lightning to
Files app to see this menu; this enables you to USB cable or
access the most commonly used file actions adaptor to connect
— including renaming, compressing, duplicating, them. It'll work with
tagging, or deleting files or folders. — iPhone too.
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Louise Blain has accep-
ted your Walkie-Talkie
invitation.

Open Walkie-Talkie

Make and take calls on your Watch

Use your Apple Watch to chat with friends — it's so easy and versatile

REQUIRES

An Apple Watch, and
someone else with an
Apple Watch

YOU WILL LEARN
How to use the
Walkie-Talkie app

IT WILL TAKE
10 minutes

-¢\-
e

GENIUS TIP

If you use Focus modes on
your iPhone and Apple
Watch to enable Do Not
Disturb settings,

they include the
Walkie-Talkie app too.
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OUR APPLE WATCH sometimes

makes us feel like we’re living in

the future; at last, we have the

wrist-based communicators our
comics promised us as kids.

When someone calls, your Watch shows
their name if they’re in your contacts. Tap
the green button to talk, the red button to
send the call to voicemail, or the “...”
(More) option to send the call to your phone

Louise Blain tried to
reach you, but you

were unavailable.

Talk to Louise

If someone tries to contact you via the Walkie-Talkie
app when you're unavailable, your Watch will display
amissed call notification.

or reply with a text message. You can adjust
the volume with the Digital Crown and
switch from Watch to Phone by unlocking
your iPhone and tapping the green bar at the
top of the screen.

And of course, you can phone people too.
Simply tell Siri to call the person, or open
the Phone app, scroll to the appropriate
contact, and choose whether to make a
phone call or a FaceTime Audio one.

ROGER, OVER AND OUT

One of our favorite features of taking calls
via Apple Watch is Announce Calls. If you go
into Settings on your Apple Watch and tap
on Siri > Announce Calls, Siri will tell you
who’s calling and ask if you want to take the
call. All you need to do is say Yes or No.

In this tutorial, we’re going to focus on

one of the lesser known voice—calling apps,
Walkie—Talkie. If you have a friend, family
member or colleague with an Apple Watch
you can use the app for instant voice
communication. All you need is for both
Watches to be connected via Wi-Fi, iPhone,
or mobile data (if your Watch is a GPS+
Cellular model). CARRIE MARSHALL



Chat to friends using Walkie-Talkie

Phone

.7 Favourites
Recents

' r
2 Conlacls

£ ) Phone home

= Open the Phone app and choose
from your Favorite contacts, your recent
calls list, or your full contacts list; you
can also select a numeric keypad or
access your voicemail here. If you prefer,
you can call with a Siri command.

Walkie-Talkie

Walkie=-
Talkie

Louise
Blain

~ ) Find a friend
> You can't just start walkie-
talkie-ing to everyone in your contacts
list. You need to invite them to use the
app. Scroll to the name of the person
and tap Invite; you'll now see this display
until they accept the invitation.

¢ Louise

) Start the chat

% Tap the name of your friend and
you should now see this button. All you
need to do now is hold the button when

you want to talk and let go when you're
ready to listen. Saying “over” at the end
of each sentence is entirely optional.

Phone 0927

Sophie Mar-
shall

CALLING IPHONE

% Make the call

" When on a call, you can mute
your mic with the left-hand icon, hang
up with the middle one, or access more
options with the “." button. This enables
you to hand the call over to your iPhone.
The Digital Crown adjusts the volume.

Louise Blain has accep-
ted your Walkie-Talkie
|nwitation.

OpenWalkie-Talkie

£ Get ready

=% When your friend accepts, you'll
get this notification, which includes an
option to open the Walkie-Talkie app if
you aren't already in it. Now when you
go to the app you'll see your friend(s) at
the top of the display.

£-0 Set your status
W If you don't want to be disturbed
at any time of day or night, toggle your
Walkie-Talkie availability in Control
Center. The toggle is just the app logo: if
it's black on a yellow background you're
available. Tap it to become unavailable.

= Voice Memos

0 Walkie-Talkie

. Wallet

‘ Weather
£ Get Walkie-Talkie

" The Walkie-Talkie app has been
automatically installed on every Apple
Watch since watchOS 5.3. If you've
deleted yours to free up space, get it
back by tapping the App Store and
downloading it again. It's a free app.

Walkie-Talkie 14:32

O

Louise

£ Add more

" Add as many other friends as
you like. Walkie-Talkie uses FaceTime to
communicate, so both of you will need
to have set up the FaceTime app on your
devices. You can remove friends from
the list by swiping left on their name.

¢2 See your status
When you've used the Walkie-
Talkie app. you might notice the icon in
tiny form at the top of the Control
Center. That's where your Watch shows
its different connection statuses, so if
Walkie-Talkie is active it appears there.
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@ Create

Spatial audio and
dynamic head tracking

Experience immersive music and sound effects

YOU WILL LEARN
How spatial audio and
dynamic head tracking
work on Apple devices

_t

KEY FACT

If your AirPods support
spatial audio, the Music app
will automatically play
spatial audio for tracks that
support Dolby Atmos. For
non-Apple headphones, go
to Settings > Music (iPhone
and iPad), or Music >
Settings > Playback (Mac).
Under the Dolby Atmos
option, select Always On.

: SPATIAL AUDIO HAS been
& e ) . .
= —.  available on iPhone and iPad for

;‘-' L 7 ﬂ‘ a few years now, since it was
"~ " introduced with iOS 14 in 2020.
It’s taken Apple a while to extend the tech
to a wider range of devices, but you’ll now
find it in the latest AirPods and AirPods
Max, as well as Macs and the Apple TV box.

Spatial audio is designed to create an
immersive sense of space when listening to
music or watching video. Spatial audio is
a bit like surround-sound speaker systems
used in cinema setups, but instead of having
to place multiple speakers around you, it is
designed to work through headphones. It
utilizes special algorithms, called HRTF
(head-related transfer function) that
convert two-dimensional stereo sound into
a kind of “virtual surround sound” using the
earpieces of your headphones.

Apple isn’t the only company investing in
clever audio tech. Sony’s 360 Reality Audio
format is available on many Sony
headphones as well as streaming services,
while Yamaha’s 3D Sound Field tech claims
to take any standard stereo audio and
upscale it to the equivalent of five—channel
surround sound.

HOW TO Configure your spatial audio settings

Stereo Audio

L]

O

Sound all around

You can get an idea of how spatial
audio works in Settings on iPhone or iPad.
The Settings panel for AirPods shows how
spatial audio differs from stereo, creating a
sense of sound all around you, rather than

just the left/right channels.
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Spatial Audio

7]
Control Center

on the Spatial Audio icon.

Open Control Center while wearing
AirPods, then press and hold the Volume
control. You'll see the Volume slider with
two smaller icons below it for adjusting
noise cancellation and spatial audio. Tap

However, Apple’s version of spatial audio
is actually based on the Dolby Atmos format,
which has been a standard format for film
soundtracks for many years, and is
becoming increasingly popular for music
recordings too. Spatial audio is supported on
the latest third-gen AirPods (but not the
second-gen AirPods that are still on sale), as
well as the AirPods Pro and AirPods Max.
However, Dolby Atmos is also widely
supported on other types of headphones and
speakers too, so you don’t have to own a set
of AirPods in order to listen to spatial audio
on Apple Music.

But, Apple being Apple, it has introduced
an extra twist, called dynamic head tracking.
This is an additional feature that works in
conjunction with spatial audio for music or
video, but it requires special sensors that
can monitor the movement of your head
while you’re wearing your headphones.
These sensors are only built into the third-
gen AirPods, AirPods Pro, AirPods Max, and

Spatial options

You have two options available if
you decide to turn spatial audio on. The
standard option is Fixed, which means that
the sound doesn't change if you turn your
head or get up and move around while
watching video or listening to music.

Image rights: Apple Inc



> SPATIAL SPEAKERS

Headphones aren’t the only option for
listening to spatial audio. You can play
spatial audio using built-in speakers on the
iPhone 7 or later, most recent iPads, and
Macs with M1/M2 chips (for a list, see
https://bit.ly/3HFyVNm).

These compact speaker systems aren't
ideal for creating the rich, immersive sound
that you really need for spatial audio. But, if
you want to go to town, you can use the
Apple TV 4K to connect more powerful
speakers and soundbars for the full home-
cinema experience — as long as those
speakers also support Dolby Atmos.

Beats Fit Pro, so these are currently the only
headphones that support dynamic head
tracking as well as spatial audio.

SPACE MUSIC

You can use dynamic head tracking when
listening to spatial audio on Apple Music,
but it works best for films or video that have
a Dolby Atmos soundtrack. When you’re
watching a film with an Atmos soundtrack,
the sound is “fixed” so that it seems to
come from the same spot within your
headphones. The spectacular opening scene
of Blade Runner sounds great with spatial

@
2 2 2
Head tracking

The dynamic head tracking feature
works best when watching video, as it can
adjust the soundtrack so that the sound
moves when your head moves, and always
appears to come from the screen that is
playing the video.

You can team an Apple TV 4K up with a pair of HomePods for a true spatial audio experience.

audio, as Harrison Ford’s hover car zooms
towards you and the sound then pans off to
the left as the hover car moves left across
the screen. With head tracking turned off,
that panning sound always comes from your
left earpiece, because the soundtrack
assumes you’re always looking directly at
the screen. But, when you turn on head
tracking, the sound is automatically
adjusted whenever you start to move your
head away — in fact, if you face 180° away
from the screen, the sound of the hover car
switches to the right-hand earpiece of the
AirPods to match the motion on the screen.

Spatial audio also works for music that
you stream or download from the Apple
Music service, as long as the tracks you’re
playing are marked as supporting “Spatial
Audio With Dolby Atmos” (and there are
several spatial audio playlists already set up
to help you get started). Spatial audio can be
really effective with a rock extravaganza
such as Bohemian Rhapsody, with the
shrieking Galileos flying through the air, or
with dance tracks that really get you into the
rhythm. However, the dynamic head
tracking is less effective when you’re
listening to music — especially if you’re also
walking around while wearing your AirPods.
Many people find that the constantly
changing direction of the sound can be quite
distracting, so check the steps (left) that
show you how to adjust both spatial audio
and dynamic head tracking to suit your
preferences. CLIFF JOSEPH

APPLE'S
VERSION OF
SPATIAL AUDIO
IS BASED ON_
THE POPULAR
DOLBY ATMOS
FORMAT

==

KEY FACT

As well as simply turning
spatial audio on or off, you
can use a feature called
Personalized Spatial Audio
to improve 3D sound
effects. This uses the
TrueDepth camera on the
iPhone X or later — which is
also used for Face ID — to
scan your head and ears
and create a personalized
profile that fine-tunes the
spatial audio effect to suit
the shape of your head.
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TECH SUPPORT & TECHSPLANATIONS

Going against the grain

WE'RE OFTEN OUR own
worst enemies when using

our Macs. When what was

once simple becomes tricky and
tenuous, instead of following the
line of least resistance, we insist
on doing what worked in the past.

Apple silicon Macs are designed
and built to run from their

internal SSD: it’s remarkably
quick, convenient, and thoroughly
secure. While they can boot from
external disks, and even a hard
drive if you really want, that
should rarely be a choice because
of everything it loses.

Those who insist it’s best face
many challenges. Things to

EXPERT
ADVICE

Our resident genius
Howard Oakley solves
your Mac and i0S problems

consider are: Can it work with a
USB sticke Is FileVault encryption
available? Can a single boot disk
work across many Macs? What
about booting older macOS? These
can be fun projects for those who
tinker, but when you want to get
on and use your Mac, it’s far better
to go with the grain.

> |s Ventura's protection good enough?

Do we still need to run third-party anti-malware software on our Macs?

Apple intends macOS to provide
sufficient protection against
malware, and last summer saw the
introduction of new anti-malware
scanning. We tested how well
Ventura 13.1 detected four current
malware samples with different
security settings. Because macOS
is now less reliant on apps being
guarantined to trigger checks,
malware was blocked effectively
even when it had dodged
quarantine. The new XProtect
Remediator anti-malware scanner,
active in Catalina and later, also
proved it does both detect and
remove known malware.

To fully benefit from built-in
protection, your Mac must run the
current release of macOS, which is
fully patched against known
vulnerabilities, in Full Security with
all security systems including SIP
and XProtect enabled.
Effectiveness also depends on
Apple’s response to new threats by
releasing Rapid Security
Responses and updating scanning
modules. Most of all, it relies on
alert users behaving securely.
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XProtect in mac0S successfully detected and blocked this sample of the malware CloudMensis from being run.
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Tech Support & Techsplanations

EMAIL: ask@maclife.com
SHARE WITH US! FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclife

Mac|Lifes®

Get official documentation at support.apple.com | Get help with hardware at support.apple.com/repair

> Sharing TV+ but not iCloud+

My partner has a new iPad. Can she share my Apple TV+ subscription
without using my iCloud storage?

Family Sharing offers many options,
and when set up carefully can provide
family members with just the shared
services you want them to enjoy.

The first step is to create your family
group in Settings. Simply tap your
name at the top, then choose Family
Sharing. and Set Up Your Family
following the instructions. In the
course of those, you'll be prompted to
send your partner an invitation to join
your family group, starting the next
step in the process.

You can always add others later by
tapping the Add Member icon at the top
right of Family in Settings. There are
limits imposed on family membership;
each Apple ID can be a member of only
one family group at a time, and can only
switch between different family
groups once each year at most.

When your partner has been added to
your group, the Family section in
Settings shows what they can access
and share, and gives you, as the
Organizer, control over those settings. To
share any of your existing subscriptions,
in Settings > Family, tap Subscriptions,
where those that are available for

sharing will be listed.

Tap Apple TV+ to enable your partner
to share that subscription, and they’ll be
sent an invitation. Once they've
accepted, it will unlock Apple TV+ access
on their iPad. Sharing iCloud storage is
controlled separately through the same
Subscriptions section, and requires an
iCloud+ subscription. As you're the
Organizer, only you can offer that, similarly with
Purchase and Location sharing.

po:04

¢ Family

Subscriptions

&ty .

Apple Tv+

Manage Your Subscriptions

iCloud+

n Apple Subscriptions

Subscriptions for Family

Sharing subscriptions to services like Apple TV+ and
iCloud+ is controlled individually within a family group.

Image rights: Apple Inc

Quick-fire
questions
& answers

WHAT'S THE

MOST VERSATILE
COMPRESSION APP?
Currently that appears
to be Keka, which gives
you the choice of 14
major compression
formats with support
for AES-256 and Zip 2.0
encryption, and can
decompress more than
30 different formats.
It's based on the same
code as its popular and
mature macOS sibling.

HOW TO ACCESS
THE MAGNIFIER
MORE EASILY?

Its app is usually tucked
away in the Utilities
section of the App
Library. For easier
access, add it to the
Control Center in that
section of Settings,
then you can swipe
from the top-right
corner to tap oniits icon
for use. You can also set
it to open when you
triple-click the side
button, in Settings >
Accessibility >
Accessibility Shortcut.
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Quick-fire
questions
& answers

HOW TO USE
M1RECOVERY

WHEN THE MOUSE
WON'T WORK?

Charge the mouse fully,
then enter Recovery
mode by holding the
Power button until
you're informed that it's
loading. To pair your
mouse again, press the
Power button three
times in slightly less
than three seconds.
You should then see the
Bluetooth Setup
Assistant to help

you pair it.

COULD I REPLACE
THE HARD DRIVE IN
MY MAC MINI 20142

Not easily. To access

the drive in more recent
Mac minis, you have to
remove almost
everything else from
inside its case, including
the logic board. This

is shown at
https://bit.ly/3InewFP,
requires special tools,
and may need an
upgrade kit if you're
replacing it with an SSD.
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Mac Hardware

We help to solve your hardware hassles, from
interrupted upgrades to running diagnostics

> More memory or larger storage?

My current Mac mini has 16GB of memory, but | find it sometimes
struggles when it's running major tasks. Should the Mac Studio I'm
getting to replace it come with 32GB RAM and a larger internal SSD, or

will I need to go for 64GB?

Trying to work out how much memory you
need in a new Mac is never really an easy task,
but one of the best indicators of your memory
requirements is how much swap space your
current Mac uses when working on those
larger and more challenging tasks. MacOS
manages memory very efficiently, and makes
the most of all the physical RAM available to it.
Activity Monitor's Memory view provides
color-coded Memory Pressure and a figure for
the amount of Swap Used, that's the space on
its hidden VM volume used as an overflow for
real memory.

If your Mac mini seldom goes into the red
and uses little swap space with only 16GB of
physical memory, your new Mac Studio should

W e

do very nicely indeed with 32GB, allowing you
to get that larger SSD. Although there are
substantial differences in the way that Intel
and Apple silicon Macs use memory, in
practice the total required doesn’t seem to
differ that greatly.

You should also ideally aim to keep your
Home folder and any currently active projects
on your machine’s internal SSD, although
moving particularly large media libraries and
less active projects to external SSDs is often a
wise economy. Lastly, ensure that you keep
at least 100GB of space free on your Mac's
internal SSD at all times, and more than that
number is even better, as that will really help to
prolong its working life.
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Enable or remove a firmware
password for an Intel Mac using
this utility in Recovery mode.

> Removing the extra password

On my Intel MacBook Pro, recently I've had to enter my password before
it will show the login window. How can | reset that?

This is probably because you've inadvertently
set your notebook to use a firmware password,
which has to be entered before it invites you to
log in. To disable that, start it up in Recovery
mode, holding the Cmd and R keys during
startup. When the Utilities window appears,
click Utilities in the menu, and choose Startup
Security or Firmware Password Utility,
whichever is available. In that, click to Turn

Off Firmware Password. You'll then be

prompted to enter the firmware password
one last time before it's removed.

Close that utility, and choose the
Restart command in the Apple menu. Your
MacBook Pro should then restart into normal
user mode without troubling you for that
firmware password. If you decide you want
to enable it again, use the same procedure
in Recovery mode, but turn it on instead
and enter your chosen password.

> Are more cores bad news?

When | ordered a new MacBook Air M2, the dealer mistakenly ordered one with a 10-core rather

than 8-core GPU. Will it get hotter and suffer from a shorter battery life?

Tech Support & Techsplanations

Quick-fire
questions
& answers

HOW MUCH MEMORY
CAN GO INTO AN
iMAC 27-INCH 2017?
[t supports a maximum
of 64GB, installed as
four matching 16GB
260-pin PC4-19200
DDR4 SO-DIMM
modules (https://
apple.co/3JLvirC).

RUNNING HARDWARE
DIAGNOSTICS ON
APPLE SILICON?
Start up in Recovery. At
the first Options screen,
hold Cmd+D until told
that Diagnostics is
loading, then select the
language for the
Diagnostics Loader to
run and offer
Diagnostics. If that fails,
Restart to Diagnostics
using the menu.

Your new MacBook Air will come with
the standard four Efficiency and four
Performance CPU cores, which bear
the brunt of its work, use much of the
power, and generate much of the heat
in its chip. However, they're used very
efficiently so that, when they're not
required to run code, they draw
almost no power at all.

The GPU handles accelerated
graphics, and is again used on demand.
When pushed, you should notice a
difference in performance from the

Image rights: Apple Inc

extra two GPU cores in the model
you're getting, but even if you do
lots of graphics-intensive work on
it, the difference in overall energy
consumption and heat
production should remain
small relative to the total.
Measurements for the 8-
core GPU give a maximum
power consumption of
about 10W, and 13.5W for
the 10-core, but with
more cores it should

O CIMEBENCH

accomplish the same tasks more
quickly. So this isn't likely to make any
detectable difference in battery
endurance, or in heat output.

Tools like CPUSetter demonstrate that GPU
use seldom accounts for a substantial
proportion of power use under load.
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e Shine a spotlight on the solutions to
your most irritating Mac problems

Quickjfire S e
questions :
& answers

HOW TO REINSTALL e S " & ' it
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- v Hars & Friamids
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THE MACOS 13.2 0:::: mxﬂ'&f‘“’ ::::n
UPDATE? i MFEg B iy 2001 0 00T . Fander - s I
e S Pl s 1 L s e B o s e ey we (e e
Because Apple & Losha e -~ s
changed how macOS i | e, e it E k] i v B
| el i iy
updates work in Big Sur, Comromrt: [ P
they now have a lot e

more work to do and
can't be supplied as
Installer packages in the
way they used to. If you
can't update through
Software Update, the
only alternative is to use
the full installer app,
such as thatin the

Mac App Store.

HOW TO KEEP
SENSITIVE FILES ON
AN EXTERNAL SSD?

r > Stop a folder from being deleted in error

volume to the existing | store sensitive documents in a folder with privileges set for
container on that drive, write only access, as a drop box. Why then could | almost
giving it a robust delete it by mistake? How should | protect it?

password. Although
perhaps not quite as

secure as FileVault This is a common misunderstanding that often  to delete either of those folders you'll at least
protection on your gives rise to problems and accidents. If you be prompted to authenticate, and that should
Mac's internal storage, want to prevent a folder from being deleted hopefully set alarm bells ringing and stop
you can eject the using permissions, you have to change the you from trashing your documents.
volume in the Finder permissions on the folder containing that Another useful tool here is locking the outer
when you're not folder, rather than the folder itself. This is of the two folders. As with permissions, this
using it. because a folder or directory is essentially a wouldn't stop you from putting either in the
list of its contents. If permissions allow you to Bin, but when you try to do so you're asked
QS e change the contents of that folder, as to confirm. Consider trusted alternative
here by adding new files to it, then they approaches too, including a separate APFS
| eyt s P also allow you to delete the folder. Encrypted volume, or an encrypted sparse
| - - To protect your folder of documents using bundle disk image, created using Disk Utility.
] _:...-:?_ | permissions alone, put that folder inside These can be given protective permissions
another folder, and set the permissions on and locked, and both can be unmounted when
that outer folder to read only. If you then try you're not using them, unlike a normal folder.
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Tech Support & Techsplanations

EMAIL: ask@maclife.com -
SHARE WITH US! FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclife MaC| Llfe=.

Quick-fire

— questions

& answers

HOW MUCH FREE
SPACE IS NEEDED
FOR VENTURA
UPDATES?

If you can plan to have
at least 20, preferably
25GB, available then
the update should
complete correctly.

. .9 WHICH DISK IMAGE
c dd t t S f FORMAT IS MOST
> Can you add a custom icon to Safari®
How can | put a custom icon on the Safari app in Ventura? Sparse bundles make
best use of storage
space, but close behind

You can't change the icon of any bundled app where you could modify them. Try that with them now are regular
in macOS Ventura, as they're now keptin Ventura, though, and the signature is broken, read/write disk images
read-only storage. Most are on the Signed so the customized app won't launch. You have (UDRW format) when
System Volume (SSV), which is a read-only one last chance: Safari Technology Preview, kept and used on
snapshot. Some come in cryptexes, special free from the Mac App Store, can have a APFS volumes — from
secure disk images that also can’t be changed. custom app icon. This is a test-bed for new mac0S 12 they're
Older versions of macOS let you work around features that may be included in future normally stored as
this by copying the app to the Data volume, releases of Safari, and often even better. special sparse files.

> How to stop switching to the wrong keyboard

L Bm QU
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: e
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Open Input Sources Remove keyboards Show Input Menu
Although you can't delete an At the left of the Input Sources You may also find it useful to show
unwanted keyboard layout, you can make dialog, there's a list of keyboards set for the Input Menu in the main menu bar.
it harder to set by accident. Open System your Mac. Remove those you don't want Select All Input Sources at the upper
Settings and select Keyboard in the list at by selecting and clicking the “~" button at left, then enable that using the top control
the left. In the Text Input section, where it the foot of the list. Add keyboard layouts on the right. Once you've finished making
says Input Sources, click Edit. by clicking the “+" and selecting them. changes, click Done to finish.
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IRST LAUNCHED WITH iOS

71in 2014, CarPlay turns
your car’s in-dash display into
an iPhone display and controller
in one. And it works brilliantly.
With your iPhone hooked up to
your car using either wired or
wireless connections, you can
easily use travel-friendly versions
of apps such as Phone, Music,
Messages and Maps, and CarPlay
supports a growing number of
third-party apps too.

Initially available on the

2014 Ferrari FF, CarPlay has now
spread to over 600 car models
from over 70 manufacturers,
including household names
such as Audi, GMC, Mercedes-
Benz, and Volkswagen. Plus, it's
available on a wide variety of
aftermarket car head units too
(we've included some options on

52 | MAY 2023

WRITTEN BY ROB MEAD-GREE[‘I_

p55) so even if you own an older
vehicle, you may still be able to
use CarPlay.

CarPlay’s other big advantage
— aside from it being the easiest,
and safest, way to use iPhone
in a car — is that it's instantly
familiar. Its interface and apps
share many of the exact same
features as your iPhone does.
Plus, it works the same no matter
which car you're using — so
whether you're hiring a car for
a weekend away, borrowing a
car from a friend, or using a take-
home vehicle, you'll feel right at
home even when you're behind
the wheel. And there’s plenty
of good stuff still to come.

So sit down, fasten your seat
belt, and let’s get started on your
CarPlay journey. It's going to be
quite the ride.

e

Image rights: BMW.
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Upgrade your driving experience with easy
access to everything you might need

HILE CARPLAY OFFICIALLY

made its debut in 2014, both the
idea and some early implementations
had been kicking around since 2008,
one year after the original iPhone
launched. That's when Apple teamed
up with Mercedes-Benz to release a car
with a 30-pin input port that enabled
the infotainment system to access

and control a connected iPhone or iPod.

The next major development came
in 2010 with iPod Out, which Apple
developed in conjunction with BMW.
Officially announced at Apple's

Car brands

with CarPlay

> Acura

> Audi

> BMW

> Buick

> Cadillac
> Chery

> Chevrolet
> Chrysler
> Dodge
> Ferrari
> Ford

> Genesis
> GMC

> Honda
> Hyundai
> Infiniti

> Jeep
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> Kia

> Lexus

> Mazda

> Mercedes-Benz
> Mini

> Mitsubishi
> Nissan

> Slingshot

> Polestar

> Porsche

> Ram

> Rolls-Royce
> Subaru

> Suzuki

> Toyota

> Volkswagen
> Volvo

Worldwide Developers Conference
(WWDC) the same year, iPod Out enabled
iPod and iPhone to output audio and
video to a car's infotainment system
and receive instructions from its control
dials, switches and knobs. That joint
Apple-BMW project resulted in a
cross-platform standard for iPod/
iPhone connectivity that other car
makers could adopt for their vehicles,
with BMW's arriving in BMW and Mini
cars as Plugin in 2011.

That was followed by i0OS in the Car at
WWDC 2013.i0S in the Car was renamed
CarPlay in time for the Geneva Motor
Show a year later. Initially, CarPlay was
largely limited to Apple’s own apps
(Phone, Messages, Maps, Books, and
others) but has since been extended to
third-party app makers across seven
main categories: Audio, VolP, Messaging,
Navigation, EV Charging (for electric

@ Library

vehicles), Parking, and Food Ordering.
CarPlay also supports apps made by car
makers, enabling it to control features
such as heating or air conditioning too.
With the launch of i0S 16 in 2022, Apple
also introduced Car Keys, which enables
anyone with a compatible digital car key
to use their iPhone or Apple Watch to
lock or unlock their vehicle instead.

THE NEXT JOURNEY

To use CarPlay, your car must of course
be equipped with a CarPlay-compatible
infotainment system and you'll need at
least an iPhone 5 (including an iPhone
5c or SE). You can also equip your car
with CarPlay-compatible head units
from manufacturers such as Alpine,
JVC, Kenwood, and Sony. Apple now
plans to take CarPlay even further with
big changes coming later this year, most
likely with the launch of i0S 17.

Flowers
Miley Cyrus
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i >

-2:56
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Being able to access almost anything Apple while getting from A to B makes traveling such a breeze.



QUICK LOOK Hands-on with CarPlay

HOME SCREEN

Just like on iPhone, the
CarPlay interface can have
multiple Home Screens,

and apps can be rearranged
in any order you choose.

5 best third-party accessories

Sony XAV-
AX4000
>$499.99
WWW.Sony.com

This double-DIN multimedia
receiver is CarPlay ready, and
features a 7in touchscreen
and support for High-Res
Audio playback. It has a 4x
55W amplifier and is rear-
view camera ready.

CUSTOM
BACKGROUNDS

With the arrival of i0S 16, you
can now change your CarPlay

background, with 11 different

wallpapers to choose from.

Pioneer AVH-
3400NEX

>$549 www.
pioneerelectronics.com
Based around a 7in color
touchscreen, this single-DIN
receiver features CarPlay,
with connection to iPhone
available via the built-in USB
cable. It also has Bluetooth
and rear camera support.

Audiobooks

iPHONE INFO

Here you can see the current
time, cell phone signal
strength, and the estimated
battery life of your CarPlay-
connected iPhone.

Kenwood
DMX9707S
>$79999
www.kenwood.com
Designed for wireless and
wired use, this receiver has a
7in color touchscreen,
Bluetooth, High-Res Audio
support, dual USB ports, four
camera inputs, and a 13-band
graphic equalizer.

Image rights: Apple Inc, Sony Group Corp, Pioneer, Alpine North America, JVCKenwood Corp.

TUE

14

RECENTLY

USED APPS

Your most recently used apps
can be accessed from the
CarPlay dock (which can be
set to the right or left side).

AlpineiLX-F511
>$1,399.95
www.alpine-usa.com
Single-DIN though this
receiver may be, it boasts an

eye-opening 1lin touchscreen.

It also has CarPlay (wired or
wireless), Bluetooth, High-Res
Audio support, a 13-band EQ,
two camera inputs, and two
USB ports.

CarPlay superguide

CHANGE THE VIEW
Tap here to switch to the
dashboard, where you can
see running apps such as
Maps, Music and Calendar,
all in the same view.

JVC KW-
M785BW
>$499.99
WWW.US.jvc.com
Available with wireless
and wired CarPlay, this
double-DIN unit includes a
6.8in color touchscreen,
Bluetooth, and a rear view
camera input. It also has a 4x
50W amplifier built in.
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How do | use CarPlay?

It's easy to get started — let us be your guide

HERE ARE TWO main ways to

connect an iPhone equipped with
CarPlay to your car's infotainment
system. The first is by plugging in your
iPhone via your car’s built-in USB port
using a USB to Lightning cable; the
second is to do so wirelessly, usually via
Bluetooth. Once that’s done (getting
connected varies from manufacturer
to manufacturer), you simply head to
Settings > General > CarPlay on your
iPhone, choose the name of your car,
then flick the CarPlay switch to On.
On the same screen, the Enhanced
Integration can help your iPhone

determine which apps that you have
installed are also compatible with
CarPlay. It will still work perfectly without
it, although you may not be able to
access all the apps you might expect.

HEY SIRI

The next steps also depend on which
CarPlay features are supported on your
car. On some, you'll be able to use your
car's infotainment controls to navigate
the interface, open apps and access
individual features within apps, while
others are just limited to, say, adjusting
the volume level during playback or to

HOW TO Make the most of CarPlay

/l Welcome to CarPlay

With your iPhone connected to your
car's CarPlay-compatible media/navigation
system, you'll see this Home Screen, which
features familiar iPhone apps such as Apple
Music, Messages, Podcasts, Calendar,
Maps, and Settings.

56 | MAY 2023

| hudible |

EngGo

More app choices

Just as on iPhone, CarPlay can have
multiple Home Screens. Swipe right or left
on the CarPlay interface to switch between
them. Here you can see a Home Screen
showing the available third-party apps
installed on iPhone.

Apple has designed
the interface to be
as recognizable
and user-friendly
as possible.

invoking Siri by saying “Hey Siri". For
the most part you'll be using the touch-
based control on your in-car display or
asking Siri to do things for you — this
can include tasks like reading out or
dictating messages. You can also, of
course, ask Siri to play content from the
Music or Podcasts apps (and third-party
apps such as Spotify or Overcast). You
can ask Siri to add or confirm Calendar
events and ask it to get Maps to direct
you to the destination. If you're running
low on fuel or power, you can ask Siri to
direct you to the nearest gas station or
EV charging point.

-

- B i Oriving Focus

AT WiTh-TarPumy

3 Change settings

To change the behavior of CarPlay,
open Settings. One of your first steps
should be to go to Settings > Focus and set
Activate With CarPlay to On. This ensures
most alerts are silenced, while others, such
as phone calls, get through.



Wallpaper

4 Choose background

To change the default appearance,
head to Wallpaper and select one of the
options there. There are 11 wallpapers to
choose from in both Light mode and Dark
mode. Tap to select one you like, tap Set or
tap Cancel to choose another.

ﬁ Settings

& 9 Google Maps
(-] a BBC Seunds
M Loy
= RingGo
© [0 Wwhatshpp
N Avecnaes
7 Remove a CarPlay app
In the same menu, tapping the “~"icon

to the left of an app will remove it from the
CarPlay interface, but without deleting the
app from your iPhone. To add an app to
CarPlay, scroll down to the More apps
section then tap “+".

223]-'1
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/l Send an ETA

You can also tell friends or family
when you're expecting to arrive. To do that,
choose Share ETA, then select the name of
the person you wish to tell. If they own an
Apple device, they'll be able to see where
you are as you travel.

The Dark side

By default, CarPlay’s menus should
automatically switch between Dark and
Light modes depending on the time of day
(e.g. sunrise/sunset); to switch them
manually, flick the Appearance > Always
Dark switch On or Off.
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Find your way

The Maps app works in a similar
way to the one on iPhone. You can choose
from a list of recent destinations, favorite
locations and new places. While some
international destinations are included,
intercontinental ones are not.

JNE2

‘ Today's Hits
App ke flusic Ml

aw Family Pop

A A Appie kg Family

Our Playlist Picks

The Agenda
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Family Road Trip

-— Appie Mo ey

/| /I Stay entertained

With CarPlay, you'll never be short of
something to listen to. In Music, you can
choose from curated playlists (including
driving-focused ones), as well as tracks
from your own Music library, whether that's
on iPhone or iniCloud.

CarPlay superguide

2:334 5

o Search wil 4G E

< BMW 82705  Customise Reset
Music
85 Maps
u Messages
[ Mow Playing
o J——

é Rearrange your apps

CarPlay will display compatible apps

installed on your iPhone. To change the
order, go to Settings > CarPlay > My Car >
[car name] > Customize on iPhone. Press
and hold the three-line icon to the right of
an app to drag it to its new position.

w B e Sl T R T el R E e B R

0 Parking

N\

Add a stop

Just as with Maps on iPhone, you can
add multiple stops en route, including for
common Points of Interest (POI) such as
Gas Stations, Restaurants and
Supermarkets, enabling you to plan
your journey as you see fit.

Pippa

/I Make use of Siri

Apple’s assistant is on hand to help
you choose where to go, what to play and
who to stay in touch with. Siri can help you
send messages and read out those sent to
you. It can also help you make and take
calls hands-free.
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What next for CarPlay?g
How the next generation a ﬂ & ” “

of CarPlay hints at an
Apple Car future s
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T APPLE'S WORLDWIDE Developers

Conference in June 2022, Apple
unveiled its plans for the future of
CarPlay — and it looks incredible. While
up until now CarPlay has been limited
largely to a car’'s in-dash display, its
reach could soon extend even further,
taking in any and all displays available in
the car, including the instrument cluster.

The aim is to create more of a unified

SBEO08®

The aim is to make CarPlay a unified experience, and many car companies are on board with Apple's plans.

makers seem to agree. Apple already join. This means that not only will

and customizable in-car experience
that'll be better than the mishmash
of interfaces and usability options
that car makers offer now — and car

10 best CarPlay apps

Apple Books
>Free (IAPs)
www.apple.com

When used with CarPlay,
Apple Books switches to
audiobook-only mode (which
makes sense), enabling you
to listen to any audiobooks
you've purchased and
downloaded to your iPhone
or have available in iCloud.
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Apple News
>Free(IAPs)
www.apple.com

Apple’s News app enables you
to keep abreast of the news
by reading out the latest
headlines and stories while
you're on the go. You will
need to be an Apple News+
subscriber (currently $9.99/
month) for full stories.

has Audi, Ford, Honda, Jaguar, Land
Rover, Mercedes-Benz, Nissan,
Polestar, Porsche, Renault and Volvo
on board, with others expected to

Amazon Music
>Free (IAPs)
https:/amzn.to/3IgFDSD
If youre an Amazon Music
subscriber, be sure

to download the Amazon
Music app to your iPhone.

It works brilliantly in CarPlay.
Just remember to sign in
with your Amazon ID on

your iPhone first.

next-generation CarPlay be able to

offer up things like Maps and Music,

but will also be able to serve up your

car's speed and mileage readings, fuel

Audible
>Free(IAPs)
www.audible.com
Another great source of
audiobooks to listen to while
using CarPlay. Audible is free
to download to your iPhone,
but you'll need to pay the
$7.95/month sub to carry

on listening after the free 30-
day trial ends.

()

Overcast

>Free (IAPs)
https:/overcast.fm

If you're looking for an
alternative to the Podcasts
app, this should be your
first stop. It's packed with
thousands of podcasts and
plays beautifully with Apple
CarPlay, thanks to its easy-
to-use interface.
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While most car makers have signed up
for CarPlay there's one major player
who hasn't, and that's Tesla. Tesla (and
Twitter) owner Elon Musk has had all
kinds of public spats with Apple over
the years, from criticizing the rumored
Apple Car to trying to shame Apple
into returning to Twitter, but the main
reason seems to be this: Tesla simply
prefers to offer its own infotainment

consumption and more. Plus, it'll also
offer features such as weather reports,
and even HomeKit controls via widgets
— handy for opening the garage doorin
advance of your arrival home — while
also controlling interior heating and
cooling, electric windows, and heated

systems to its customers. One
enterprising Polish developer, named
Michat Gapiriski, still managed to
create a successful workaround
though —in 2022, he equipped a
Tesla Model S with CarPlay using a
combination of Android, Linux, two
Raspberry Pis, an LTE modem, a
Wi-Fi access point and some cables.
It's a kludge, but it works.

CarPlay superguide

seats. There'll even be a new Radio app
with an Apple Music-like interface that

includes playback controls and artwork,

all of which makes you wonder where
Apple might go next.

While some of these new CarPlay
features are simply applying Apple’s

design sense to the electronic
dashboards that are increasingly being
offered in modern cars, their reach
suggests that Apple’s rumored Apple
Car project may be finally bearing fruit —
first CarPlay controls then, in time, the
car itself? Watch this space..

=

Spotify
>Free(IAPs)
https:/spotify.com
Spotify may have a bit of

a love/hate relationship with
Apple, but its streaming
service is a great alternative
to Apple Music, with 100

million tracks and five million
podcasts to choose from.
It's easy to use too.

Tidal

>Free(IAPs)
https:/tidal.com
Another awesome alternative
to Apple Music with both an
ad-supported tier and a
paid-for tier. With over 100
million songs to choose
from, you'll never be short
of a soundtrack for your
latest road trip.

WhatsApp
Messenger

>Free
www.whatsapp.com
Meta's messaging app works
very well with CarPlay, with
Siri helpfully stepping in to
both read out your messages
and dictate your replies. It's
a great way to stay in touch
when you're on the go.

TomTom GO
>Free(IAPs)
https:/bit.ly/41ALvFZ
While TomTom'’s sat nav app
costs from $4.99/month, it
also has several advantages
over Apple Maps, including
offline maps for those times
when you can't get a mobile
data signal either via your
car or your iPhone.

£

Waze

>Free

www.waze.com

This Google-owned sat

nav app is famous for its
crowd-sourced real-time
updates, giving you early
warning of traffic jams,
accidents and other nasties.
It can even help you find the
cheapest places to refuel.
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GET STARTED WITH

eminders

Never forget those
important tasks again

WRITTEN BY KENNY HEMPHILL

‘ APPLE'S REMINDERS APP has come a long

v way over the last few years. From a fairly

basic to—do list tool that allowed us to set

alerts, to a fully fledged task manager that supports
multiple lists, tagging, and sharing with others. Throw in
the fact that it syncs with iCloud across all your devices,
and there’s no excuse for forgetting anything ever again.
And if typing details of a task into your iPhone or Mac is
too much effort, you can ask Siri to do it for you. Creating
basic reminders really couldn’t be easier. But Reminders
goes way beyond the basics.

Let’s say you want to remind yourself to buy tickets for
a concert just before they go on sale. You could create the
reminder, add the URL of the ticket sales site and the
price of the ticket. That way, when the reminder alert is
triggered, you can just tap the reminder to navigate
directly to the website. Need to remember to buy milk
next time you’re in the supermarket? Set a geofenced
reminder that’s triggered the next time iOS senses your
location is close to that supermarket.

As we’ll demonstrate over these next few pages, it’s
easy to create and schedule reminders, make your own
lists, or templates for lists, and store them in folders.
Plus, you can build Smart Lists based on tags, collaborate
on shared lists with others, and much more. =

Get started with Reminders
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Scheduling reminders notifies
you when they're due, taking
the pressure off your memory.

Build efficient to-do lists

Create and schedule Reminders to help manage all your important tasks

SOME PEOPLE CREATE

v‘ lists for every little thing
and meticulously record

every task. Others never make a note
of anything and trust their memory
not to let them down. Most of us fall
between those two camps and write
down important tasks while
entrusting the rest to memory.

However, with a tool like Apple’s
Reminders close at hand, there’s no
excuse for relying on memory. Using
Reminders to “dump” everything you
need to do can be very liberating, and
reduce your stress levels.

Here we’ll show you how to create a
basic reminder, schedule it, add it to a
list, and set notifications for when it’s

QUICK LOOK The Reminders interface

time to complete the task. We refer to
the quick actions menu in some steps
— this lives above the keyboard on
i0S and appears below a reminder
when you click it on the Mac. If you
don’t have your Mac, iPhone or iPad to
hand, you can create reminders on
Apple Watch or by asking Siri via a
HomePod or AirPods. =

o

TASK ORDER a

The main screen handily
categorizes tasks so you
can quickly access those
due Today, or those you've
scheduled or flagged.

(&)

CREATE LISTS

You can create your own
lists to organize tasks,
share the lists with others,
and group them in folders.
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ADD A REMINDER

To add a Reminder, you can
either click the “+" icon on
the main screen, or select a
list and then choose the

New Reminder option.

(0]

INCLUDE TAGS
Adding tags to reminders
allows you to create a
Smart List and filter tasks
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by their tags.

e [T Bgbd e

Image rights: Apple Inc.



HOW TO Create and schedule reminders

Get started with Reminders

¢ Maotificallons  Reminders
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Set notifications

Notifications are important for
Reminders because they govern how
you are, well, reminded. Go to Settings >
Reminders > Notifications and choose
from the options. On Mac, it's System
Settings > Notifications > Reminders.

R i [ @]

July 2023 < Y
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Set the date (i0S)

Tap the reminder, tap the
calendar icon above the keyboard, then
tap Date & Time. Navigate to the date
and tap it, then set the Time switch to
on and use the rollers to set a time. You
can also set date and time by tapping “i".

Canzed Mew List Dane

Bl st Templates

Garden Spring 2023

Create a list

Oni0S, on the main screen, tap
Add List. Type a name and then choose
a color. Tap an icon and then tap Done.
On the Mac, click Add List or File > New
List. Type a name, choose a color, and
click the icon to choose one.

Image rights: Apple Inc.

o Renovation Project

e New Reminder B 1=t

Create a reminder
(i0S)
Tap Reminders, then New Reminder.
Give it a title and add any notes. Tap List
and choose a list to add the reminder to
it. Tap Add. You can also tap a list in the
main screen, then New Reminder.

it mi i i

Set the date (Mac)

Click on the reminder and click
the “I". If you created it in Today, it will
already have On a Day checked. If not,
check it. Check “At a Time". Click on the
date and time and set values for each.
Click the “i" to finish.

(=
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Books To Read

d @) cardensping 2023

Group lists

To group lists in a folder in iOS,
tap and hold on a list, drag it over one
you want to group it with, and drop it
onto it. Type a name for the group.
Repeat for other lists you want to add.
On Mac, drag and drop instead of tap.

Create a reminder
(Mac)
Launch the Reminders app. Click the “+"
in the top-right corner of the window.
Type a title and add notes. You can drag
the reminder over a list in the sidebar
then drop it onto it.

Cangn

Tags
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Add tags

Tap or click on the reminder,
then the “i”. On i0S, tap Tags and type a
tag name in Add New Tag. On Mac, click
on Add Tags and type one. Once you've
created a tag, you can choose it from
the quick actions menu.

.
| Q Glazgow Trip
Fin z
W Show List Info @
Share List 03
Manage lists

To delete a list on iOS, tap and
hold on it, then choose Delete List. On
the Mac, Ctrl-click on it and choose
Delete. To pin a list to the top. tap and
hold or Ctrl-click on it and choose Pin
on i0S or Pin List on Mac.
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Reminders enables you to
build templates for lists you
create frequently.

Do more with Reminders

Now that we've mastered the basics, it's time to go deeper

YOU NOW KNOW how

v‘ to create and schedule
reminders, tag them, and

create and manage lists, so it’s time to
make them really useful. For example,
by using the Smart Lists feature, you
can create lists that include reminders
based on tags, meaning you don’t
have to manually assign them to a list.

You can also collaborate on lists. For
example, if you have a groceries list,
you can share it with other members
of your household so you can all add to
it or check off items as you buy them.
Items on lists can be geotagged so you
are alerted when you arrive or leave a
specified location. And you can make
and save templates for lists that you

HOW TO Make a Smart List

Renovation |

E Make wrto Srriart List

Create the list

We're making a list for a home
renovation project. Create a list as in
step 7 on p63. Before finishing, select
“Make into Smart List”. To choose tags to
use as filters, tap Tags, or click in the box

on Mac, and choose the tags.
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More conditions

We want to exclude a list that
has general chores in it. Tap Lists, then
Exclude or, on Mac, click “+" then

Choose the list. To set a date range,
choose Date > Specified Range.

choose Lists and Exclude Selected List.

create regularly, such as a packing list
for trips.

You can add URLs, images, and text
notes. And, by using Share sheets, you
can add reminders from an app. This
way, you can remind yourself to
complete a task by visiting a website
and already have the URL and preview
of the page in the reminder. =
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Share with others

You can't share a Smart List, but
you can share regular lists. Tap or click
on the Share icon and choose a method
by which to share. Fill in the details of
the person you want to share with and
click or tap Send to invite them.

Image rights: Apple Inc.



HOW TO Create and use templates

Get started with Reminders
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e Travel List

Build a template

To create a template, you need
to use an existing list. We're using a list
created for a trip. Tap or click on the list
you want to use. On Mac, click File then
“Save as Template”. On i0S, tap More (“.")
and “Save as Template”

Finish creating

Type a name for your template
and click Create on Mac or tap Save on
i0S. To use a template, click or tap Add
List, then choose Templates and click or
tap on the template and name the list.
Tap Create, or click Create List.

HOW TO Set up content-rich reminders

G WaChat

Remindars

(@) nstagram

e Amaron Alexa
[ wnatsaop

Create from

web page
Navigate to the web page in Safari. Click
or tap on the Share icon and choose
Reminders. On Mac, click “i" to set the
date and time and choose a list from the
menu. On i0S, tap Details and choose.

Repest Never
Tags ) Eatmotact
Location
[0 When Messaging O
@ corol Hemphil Edi
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Add an image

Select a reminder and tap the “i".

On Mac, click Add Image. On iQS, scroll
to the bottom of the options and tap
Add Image. Choose Photos to add from
your Library. On iPhone, you can also
take a photo or scan a document.

> SIRI AND REMINDERS

ol List — it 7

T

ol e 15 i B

Edit the list

Lists created from templates
include tasks from the original lists and
their original due dates and times. To
change these, tap or click the “i" next to
the task and assign new values for date
and time. Next, add new reminders.

Priprity I

List » Wil
Subtasks

A L e

Split into subtasks
You can break tasks down into
subtasks. On i0S, tap a reminder and tap
the “I", then tap Subtasks and Add
Reminder. On Mac, create a new task,
then select it and either press Cmd+]
or drag it on top of the parent task.

Get even more appointment assistance from Siri

You can use Siri in conjunction with Reminders in several ways. The most
straightforward is to say “Hey, Siri" within range of an Apple device that can
“hear” you, such as an iPhone, HomePod, AirPods, or Apple Watch. You can
then ask it to set a reminder for a specific time and date.

However, you can also use Siri's artificial intelligence and ask it to remind
you of a task you created while you're having a conversation with someone in
Messages. And Reminders has several actions for Shortcuts, as well as a handful

of pre-created shortcuts in the Gallery.
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Affinity Publisher 2 for iPad

Pro publishing in a portable package

$19.99 (standalone), $169.99 (universal license)

From https://affinity.serif.com

Needs iPadOS 15 or later, Apple silicon recommended

A PRO-GRADE DTP app on the
iPad? It's true. The release of the
second version of the Affinity suite
of creative apps has seen Serif
take a step that it chose not to with the
previous iteration, which saw the Designer
vector illustration app and the Photo image-
editing app move to touchscreen town — but
not Publisher.

Publisher 2, therefore, has something to
prove. Happily. it largely manages to show that
having a full creative suite on an iPad is a good

idea, and Apple’s introduction of Stage Manager
into iPadOS couldn't have come at a better time.

While it's probably still best to work with the
app using a mouse, keyboard and external
monitor, the Apple Pencil support means it's
possible to use Publisher as if your iPad was a
graphics tablet, as plenty of graphic designers
do with desktop apps like InDesign.

PUBLISH ON THE GO
If you're used to Adobe’s app, learning the new
interface is key to gaining proficiency, but may
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One main “..." menu contains many common commands, saving hunting.

take some time. The interface is nicely minimal to
make the most of the limited screen space, at the
expense of being able to find things if you're not
already aware of their location, and which can be
completely removed at any time for a fullscreen
view of your work. Tooltips and generous help files,
as well as online tutorials, go a long way to easing
the transition.

Adobe’s IDML files can be imported, and PSD
files can be placed (including editable text), as can
WebP, JPEG XL, and even raw images which can
then be edited. And of course there’s full PDF
export too. Save your documents to the cloud
(there’s Dropbox integration in the app, with Files
for everything else) and you can work on them on
Macs or even Windows PCs seamlessly.

And while Serif embraces Adobe’s file formats, it
rejects its pricing structure. There's no
subscription, and buying the Universal License
gets you all three apps in the suite on both
desktop and iPad. With all three installed on your
iPad, StudioLink works in exactly the same way as
it does in the desktop, changing the toolset to
directly edit raster or vector images in the layout.

Publisher has some well-thought out features
that will appeal to anyone laying out publications
from a leaflet to a full magazine. Our favorite is
that every object is on its own layer, making the
vertical stacking of text and images easier. The
iPad version also gets a Command Controller, a
gray disc that looks rather like the on-screen
joystick from a game, but which provides easily
accessible options for tools, replicating the

EEsEEAER AL EEET =

Free stock images from Pixabay and Pexels can be searched
from the Stock panel, ready to be added to your layout.

modifiers on a keyboard. You can use it to
constrain proportions, toggle snapping. and lots
of other useful things.

Affinity Publisher 2 is an ambitious app. but
succeeds in what it sets out to do, and even
goes some way to justifying the iPad as a serious
work device. It may take some time to become
familiar with its systems and methods of
interaction, however, if you'd rather use an iPad
than a MacBook. IAN EVENDEN

Export options are vast, catering for print-ready
PDFs, PSD files, and web formats.
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THE BOTTOM LINE

An auspicious debut
for Affinity Publisher
on iPad.

Excellent performance on
iPad Pro

Well-thought out
app features

£ Comprehensive help files

& Interface will take
some learning

AWESOME BumEm

MAY 2023 | 67



Logitech’s MX Keys Mini
looks and performs just as
well as the Magic Keyboard.

THE BOTTOM LINE
A brilliant Magic

Keyboard alternative,
though it's as pricey.
Exquisite Apple style
Very comfortable
Compact

£ No wired option
EXCELLENT mmmmy
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Logitech MX Keys Mini for Mac

A great match for your Apple-oriented desk space

$99.99 From www.logitech.com

Features Bluetooth, easy-switch keys, hand proximity sensors, 519 x 11.65 x 0.82in, 17.86 oz
Needs macOS 10.15 or later, Bluetooth Low Energy enabled device

WANT A WIRELESS alternative to Apple’s Magic
Keyboard? Then consider the MX Keys Mini for
Mac. It combines an Apple-friendly aesthetic
with all the shortcuts and key legends (Cmd,
Opt, et al) a Mac user would need, with a
built-in battery for Bluetooth LE connectivity
and multi—-device pairing. Its white keys on a
silver base are a great match for Apple’s
products. It’s compact and solidly built too,
with rubberized strips on its underside to stop
it slipping on your desk.

Logitech’s “Perfect Stroke” keys are close to
those in the latest MacBooks or the Magic
Keyboard line — low profile and easy to
actuate. With a satisfyingly tactile feedback
they feature a slightly concave surface for
comfortable and accurate touch-typing. The
keys also feature a “Made for Mac” layout,
which is neat.

It has an ace that Apple’s offerings can’t
match — smart backlighting. A proximity
sensor adjusts the backlight when your hands
aren’t near, to save battery life. Logitech

promises ten days with the backlight on and
up to five months with it off. That seems low,
but thankfully charging is easy — a USB-C
port is easily accessible in the top corner.

An entire row of function keys sits along the
top, with useful presets. The keyboard
supports up to three paired Bluetooth devices
(including iPhone/iPad/Mac) at a time, and the
first three keys let you quickly switch between
them. Other keys allow you to toggle backlight
control, dictation, volume, and more.

With so many positives, it’s easy to overlook
the negatives, but they’re there. For one, the
angle of the keyboard can’t be adjusted, which
might not suit those wanting to be able to
adjust the ergonomics. And you can’t use the
keyboard wired over USB-C either (it’s only for
charging). It’s also the same price as the Magic
Keyboard; Apple silicon fans may prefer the
$149 version with the convenience of Touch ID.
If you’re looking for cheaper options,
Logitech’s K380 keyboard offers similar sizing
and Bluetooth functionality. GERALD LYNCH

Image rights: Logitech



A Little to the Left

Punctilious puzzles for the meticulous gamer

$14.99 From www.maxinferno.com
Needs macO0S 10.13 or later

Tough testing, trusted ratings

X FOR SOME PEOPLE, keeping
B ! things neat and orderly is its
& a&h  own form of satisfaction. If you
L= enjoy the challenge of ensuring
everything exists in its proper place (while
dealing with a meddlesome cat), A Little to
the Left could be your kind of game.

Taken at face value, there are a lot of
similarities between A Little to the Left and
another Mac game, Unpacking. Both task
you with organizing household scenes and
objects, and both do it wordlessly without
offering much in the way of assistance.

But if Unpacking takes a higher view,
telling a story that unfolds over many years
through the objects you are sorting and
placing onto shelves, A Little to the Leftis
focused much more on the minutiae. Each
puzzle consists of a set of household
objects — a set of pencils, some pasta
shapes, various bottles of home cleaning
products — that you have to drag and drop
into the right order.

Things start out easy, with you simply
needing to line up books in height order or
arrange sticky notes to make a joined—up
shape. As you progress, the puzzles get
trickier, and there are plenty of satisfying
“ah ha!” moments to be had. Every now
and then, though, a pesky cat will mess up
your puzzle solutions with a grasping paw
or a swish of its bushy tail.

Occasionally, the resident cat will interfere by swiping at
your completed puzzle, sending it into disarray.

Image rights: Max Inferno Studio Inc.

TIDY HOUSE, TIDY MIND

A Little to the Left’s lack of exposition is
sometimes an issue, and we stumbled on a
few puzzles where it was not at all clear
what was being asked of us. If you’re stuck,
though, there is a hint page that’s there to
help. You can use an eraser to uncover the
solution on a page, which allows you to
reveal just as much as you need without
giving the game away.

We admired Unpacking for its ability to
immerse you in the world of an unseen
protagonist purely through examining the
objects in their life. A Little to the Left
doesn’t offer that kind of joyful
exploration, but the bite-sized nature of its
puzzles lends itself well to short bursts of
problem-solving.

We enjoyed the colorful, hand-drawn
nature of each puzzle, while the audio
design — both the quirky music and the
realistic sound effects — was excellent.
While the game’s lack of narrative means A
Little to the Left never quite hits the
heights of Unpacking, if you liked the

latter, the former will scratch a similar itch.

ALEX BLAKE

Each puzzle tasks you with
arranging items into correct
(and pleasing) locations.

THE BOTTOM LINE

A relaxing puzzler
that's easy to dip
in and out of.

B Creative puzzles

3 Lovely visuals and audio

& We'd love some story

& A touch more exposition
would be welcome

GREATHEEER
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On the back is a Powerfoyle
solar panel that keeps the
Phoenix’s charging case
juiced up.

THE BOTTOM LINE

Banish charging
cables forever with
the power of light.

Impressive battery life
Enjoyable audio

& Bulky case

£ Fiddly gesture controls
GOOD mmm:
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Urbanista Phoenix

These headphones will never need charging

$149 From www.urbanista.com

Features Light-powered charging case, 34-hour reserve battery, hybrid active noise canceling,
ear detection, transparency mode, Bluetooth 5.2, IPX4 water resistance, eight-hour playtime

IN ISSUE 193, we tested and reviewed
Urbanista’s solar-powered Los Angeles
headphones. Now, the company has
transplanted its light-fueling tech into the
more compact Phoenix earphones.

In the Los Angeles, a solar—charging strip
was integrated into the headband, but of
course it works differently in the Phoenix
earphones. Each earbud is too small to fit any
kind of solar panel, so instead a roughly
two—inch-squared light cell sits on one side of
the charging case, which in turn juices up the
earbuds. It works with artificial light too, not
just sunlight.

The result is a case that charges the buds
forever, cable-free. The earphones get around
seven and a half hours of juice themselves, but
the case will never run out of power providing
it’s exposed to light. The box also has a 34~
hour reserve battery to pull you through darker
times. Note that since there’s no solar panel
on the earbuds, they won’t charge up as you
use them.

Audio is well-balanced and the Phoenix
capably handle a range of genres. Highs and
mids are clear and detailed, although lows can
get a little muddy on complex, layered
arrangements. There’s active noise
cancellation (ANC), but unfortunately we
struggled to differentiate it from the default
mode, which is disappointing. The touch
controls, meanwhile, are extremely
temperamental — we struggled to get the
rewind gesture to work, for instance.

The earbuds are stylish and look good when
worn. When you take them out, your audio
pauses and resumes when you put them back
(although it can restart a little early). The case
is bulky and, while not heavy, it’s still about
twice the size of an average charging box.

The battery life is the main pull, but the
Urbanista Phoenix is no one—trick pony. The
pleasing audio and good looks mean you’re not
simply trading longevity for everything else.
Hopefully the next version can iron out the
kinks. ALEX BLAKE

Image rights: Urbanista.



Proton Drive

Private encrypted storage

Free (1GB); $59.99/year (200GB); $149.99/year (500GB + Proton
Mail, Calendar and VPN) From https:/proton.me

Needs i0S/iPad0S 15.0 or later
IF THE IDEA of
locking your private

p data away in a Swiss

vault is attractive,

then Proton Drive might be the
perfect solution. It’s a new
encrypted cloud storage service
from the Swiss firm responsible
for Proton Mail, and sits
alongside that, Proton VPN and

Proton Calendar, in a suite

aimed at providing robust
privacy protection.

At its heart, it’s an app to
encrypt files on your device and
upload them to Proton’s servers
for safe keeping. Because the
password and encryption are
kept on your device, Proton
can’t access any of the data you
store there, only you can. Or,
rather, anyone with your
username and password can.

The Proton Drive app gives
you access to all the encrypted
files stored in your Swiss vault,
but is only weakly integrated
into i0S, and doesn’t appear as a
Share action. Saving from
another app straight into your
vault isn’t allowed if you’ve
enabled Face ID for accessing
the app. This leaves you saving
each document locally or into
iCloud before using Proton Drive
to encrypt and upload it.

Some documents cause
problems: RTFD is really a
folder, and has to be Zipped by

Image rights: Proton AG.

Proton Drive before encryption
and upload. Accessing it from
within your vault is fraught, as
it doesn’t seem to reconstitute
readily. As documents are
recognized by their MIME types,
some may not turn into the
expected iOS type.

Neither is the iOS app
complete. It does let you enable
local Face ID or authentication
by PIN, but to protect your
account using 2FA or an
authenticator app, you have to
resort to its web interface,
where there’s no support for
passkeys yet. While Proton
keeps a full log of all access to
your vault, that too is only
accessible in a web browser, not
in the Proton Drive app. Unless
you access your vault through
its web interface, you’d never
learn of any third-party access
to your sensitive files. None of
this is helped by the almost
complete lack of documentation
and tutorials.

Proton has high ideals and
strong community support for
what looks like an excellent
independent service. At present,
though, its Proton Drive app is
little more than a proof of
concept, and badly needs tighter
integration and support for
account security. It’s not yet a
serious contender against
iCloud. HOWARD OAKLEY

Tough testing, trusted ratings
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THE BOTTOM LINE

While its protection looks
promising, it needs tighter
integration before it might
challenge iCloud.

Ambitious intentions
Excellent service protection
B Lack of integration

B Key options web-only
OKAY mmi
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The Scribe’s battery life is
classic Kindle — it just
seems to go on forever
(well, weeks anyway).

An optional folio case
can keep the pen in place
when inserting the Scribe
into a backpack.

THE BOTTOM LINE

A brilliant big-screen
Kindle, but there
aren't many writing
features here.

B Big & clear display
Excellent battery life

B Few writing features
for academics

£ Expensive when bought
as an e-reader

GOOD mmm=n
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Kindle Scribe

More of a sticky note than a scribe

From $339.99 (16GB, Basic Pen) From https://amzn.to/3IgFDSD

Features 10.2-inch, 300 ppi, auto-adjusting front light, 16/32/64GB, USB-C, magnetic pen

THE KINDLE SCRIBE is a large-screen Kindle with
a pen included, allowing you to write on it, though
it's basic in that respect — more so than competing
tablets like the reMarkable 2. A Premium Pen is
available (830 extra), offering an eraser and a
shortcut button, which are useful additions if you
need them.

If you want to read books on a large-screen
Kindle, the Scribe is an easy ereader to recommend.
The huge pixel density means everything is super
sharp and glorious on-screen. However, for
journaling, note taking, and other writing tasks, the
Scribe is a letdown. For students and academics,
the Scribe only allows you to write notes as sticky
notes appended to a book. You cannot actually
write on the book page, in the margins, for instance.
For journaling and freewriting, the Scribe offers few
template options, and none that work well with
popular journal methods. If you use bullet journaling
there are basic dots and lined pages, but nothing as
organized or creative as the templates on the
reMarkable 2.

Another disappointment is that there’'s no way to
convert handwriting to typography. This would be a
great way to search through all of the sticky notes

taken on a book, or a better way to send a written
document via email.

That said, the writing experience on the Scribe
with its Basic Pen is the best we've experienced to
date. It is extremely smooth, and it's hard to convey
how good it really is to write on that screen. But if
you were hoping to doodle and draw, the Kindle
Scribe is not interested. You get a pen, a highlighter,
and an eraser — that's it.

Amazon makes it easy to set up the Kindle Scribe
and get all of your books and documents on and off
the device. It's easy to connect to a Wi-Fi network,
and the Kindle doesn't need a second device for
setup. An iPhone with the Kindle app helps speed
the process along, but it isn't required.

Some folks may want an LTE connection at least
for downloading books or emailing simple black-
and-white documents on the move. Amazon sells a
deluxe version of the Kindle Oasis with 4G LTE, so
it's a little strange to see the Scribe miss out..
although we suspect the price alone for that
privilege may be prohibitive for most potential users.

We wish the pen added more value, but this is still
a brilliant ereader, with a great screen and excellent
battery life. PHILIP BERNE

Image rights: Amazon.



Fiio BTR7

Versatile and portable DAC/amp

$199.99 From www.fiio.com

Features 1.3-inch IPS color display, 9 hour battery life, Bluetooth with AAC, aptX HD, USB-C,
3.5mm and 4.4mm connectors, 0.57in x 1.56in x 3.29in, 2.40z

THERE ARE SEVERAL portable DACs now
available that are primarily designed for use
with smartphones. Fiio’s BTR7 isn’t as
compact as some of its rivals, but its
impressive range of features mean that it
works well with a much wider selection of
devices. We tested the standard version of the
BTR7, which has a USB-C interface for use
with Macs, PCs, and the latest iPads, but
there’s also an “Apple Deluxe” edition
available for $210 that includes a Lightning
adaptor for the iPhone and older iPads.
Unlike most portable DACs, the BTR7 has a
rechargeable battery, which means it doesn’t
drain the battery of your smartphone or tablet
while you’re using it. Fiio quotes a battery life
of nine hours, although we got just over seven
hours during our tests — but that’s still
enough for day-to—day use when traveling.
There are both 3.5mm and 4.4mm
connectors for wired headphones, and the
BTR7 includes two DAC chips and two
amplifier modules that allow it to drive even

high-end hi-fi headphones. It supports
lossless and high-res audio formats up
to 32-bit/384kHz and, unlike most
portable DACs, the BTR7 also supports
Bluetooth too.

When we connected our Yamaha L700
headphones to the BTR7 via the 3.5mm
jack, we were really impressed by the
deep, firm sound of the slap—bass on
The Big Sky by Kate Bush. The track’s
avalanche of drums and percussion
sounded great too, but the BTR7 was still
able to pick out lighter details, such as
the shimmering tambourine floating in
the background and, of course, Kate’s
soaring vocals. Our only complaint is
that the screen isn’t touch—-sensitive,
and the controls for navigating through
the settings can be a bit awkward at
times. But, if you’re an audiophile who
really wants the best sound quality for
their wired headphones, then the BTR7
is a versatile option. CLIFF JOSEPH

The BTR7 is larger than
some of its portable
rivals, but is loaded
with useful features.

THE BOTTOM LINE

The controls could be
improved, but the
BTR7 provides great
sound quality

and versatile
connectivity features.

£ Supports hi-res audio

& 3.5mm and
4 4mm connectors

£ Bluetooth connectivity
& Clumsy controls
GREAT mmmm
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The microphone uses a
click dial system to let you
control levels, routing, polar
patterns and even the
built-in filter.

THE BOTTOM LINE

A versatile and great-
sounding mic and
interface for
podcasters, musicians,
and voiceover artists.
2 Clear and solid sound
Four polar patterns

£ Onboard mixing features

£ An extra physical audio
input would be a bonus

EXCELLENT mmmms
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K Multimedia

IRig Stream Mic Pro

Flexible recording for Mac and i0OS

$169.99 From www.ikmultimedia.com

Features 24-bit, 96kHz recording; stereo or four-channel operation; four polar patterns;
direct monitoring; dual, gold-sputtered 0.55-inch capsules; 20Hz to 20kHz frequency response

IK MULTIMEDIA PRODUCES a range of audio
devices that straddle the worlds of music-
making and podcasting, with a focus on
portability. The iRig Stream Mic Pro is a
microphone that doubles as an audio interface
for your Mac, PC, or iOS device. Entirely self-
contained and requiring no drivers, it comes
with Lightning and USB-C cables and will
power from your device, an optional power
supply also allowing the charging of i0S
devices when in use. You also get an adjustable
metal desk stand and a thread adapter should
you wish to mount the mic on a larger boom.

The microphone eschews IK's more
traditional side-mounted buttons in favor of a
clever one-dial system for controlling its
various features. Your first step will be to
choose the polar pattern, with four available by
clicking and rotating the dial. The front-facing
cardioid pattern is the most common, suitable
for vocals, streaming, instrument recording
and podcasting. Omnidirectional picks upin a
360-degree field, while Figure 8 picks up
equally from behind and in front, good for
face-to-face interviews, and finally Stereo
from left and right.

Click the dial again and you can select a
three-position adjustable high-pass filter,
which will cut out rumble and other unwanted
low frequencies. Clicking through further you
can easily set headphone, streaming level,

loopback and monitor mix control levels. By
default the microphone mixes down the four
available channels to stereo for sending to your
software, but it can also be switched into
multitrack mode in which case its four
channels will be sent separately, giving more
options when mixing — for example to capture
your vocal to one track and a stereo source like
a keyboard to separate tracks.

PERFECT FOR PODCASTERS

The microphone’s loopback mode, when
activated, can take audio streamed from your
device over USB and blend it in with the mic's
signal before sending it back, which is handy
for recording an online participant as part of a
podcast for example. Despite the unit's
compact size you can manage how you hear
the various signals in your headphones, with
direct monitoring and monitor mixing,
controllable via the main dial.

This is a great all-round streaming
microphone that will suit podcasters, voiceover
artists and indeed those recording singing or
acoustic instruments. It's versatile and easy to
use and the click dial system is preferable to
button-based methods. While it's nice to have
the aux in and loopback features, and they are
genuinely useful, it won't substitute for a fully
blown multichannel audio interface, but then it
is much more compact. HOLLIN JONES



iRig StreamMIC

\ AUX N PRO  WPOUT

THE MICROPHONE'S LOOPBACK
MODE CAN TAKE AUDIO
STREAMED FROM YOUR DEVICE
OVER USB AND BLEND IT IN
WITH THE MIC’'S SIGNAL
BEFORE SENDING IT BACK
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@ Reviews
Best of the best

Can't find the hardware or app you're looking for in our reviews section? Then check in
here — we've highlighted the best in every major category, as voted for by us

> HARDWARE

T I S S 3 3
MESH ROUTER ASUS ZenWiFi XT9 asus.com $449.99  #201
4K USB-C MONITOR Ben( EW3280U beng.com $799.99  #169
THUNDERBOLT DOCK CalDigit Thunderbolt Station 4 caldigit.com $379.99  #199
KEYBOARD NuPhy Air75 Wireless Mechanical nuphy.com $109.95  #189
PORTABLE PRINTER Epson WorkForce WF-TI0W epson.com $299.99  #185
PORTABLE HDD Toshiba Canvio Flex 2TB storage.toshiba.com $79.99  #197
NAS DEVICE Asustor Lockerstor 2 Gen 2 AS6702T asustor.com $459 #205
WIRELESS CHARGER Belkin BoostCharge Pro Portable belkin.com $59.99  #197
DESKTOP SPEAKERS Creative Pebble Pro us.creative.com $59.99  #204
IN-EAR HEADPHONES Beats Fit Pro beatsbydre.com $199.99  #190
SECURITY CAMERA EufyCam 2C (two-pack kit) eufylife.com $239.99 #IN
SMART SPEAKER HomePod mini apple.com $99 #176
OVER-EAR HEADPHONES Sony WH-1000XM5 sony.com $399.99  #197
AIRPLAY SOUNDBAR Sonos Beam S0N0S.COM Sk #187
WEBCAM AnkerWork B600 Video Bar ankerwork.com $219.99  #191
PHOTO PRINTER Liene 4x6 photo printer amazon.com $136.99  #190
PORTABLE BATTERY PACK Anker 533 us.anker.com $4999  #198
MOBILE DOCK Kensington 8-in-1USB-C Mabile Hub kensington.com $7755  #190
OFFICE CHAIR Branch Verve branchfurniture.com $549 #201
MOUSE Logitech MX Master 3S logitech.com $99.99  #198
ACTION CAMERA GoPro Hero 11 Black gopro.com $500 #202
SMART TV PLAYER Roku Streaming Stick 4K roku.com $49.99  #190
PORTABLE DAC iFi Go Blu ifi-audio.com $199 #189
PORTABLE SSD Crucial X8 crucial.com $219.99  #203
THUNDERBOLT 4 HUB Satechi Thunderbolt 4 Slim Hub satechi.net $199.99  #205
CD/DVD DRIVE NOLYTH External DVD Drive amazon.com $39.99  #204
TRAVEL CHARGER Mophie 3-in-1travel charger zagg.com $149.95  #202
iPHONE GAME CONTROLLER Razer Kishi v2 razer.com $99.99  #203
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> i0S/iPadOS APPS
PRODUCT W |PRIcE__issuE

T0 DO (PRODUCTIVITY)
WRITING

EMALL

PHOTO EDITOR

VIDEO EDITOR
CAMERA

RSS READER

5 { DESKTOP PUBLISHING
NOTE-TAKING
MIND-MAPPING
DOCUMENT SCANNER
CALENDAR

FITNESS

SHOPPING

GRAPHICS

Things 3

& Scrivener

0 spark

@ Pixelmator Photo 2

8 LumaFusion3.0

@ obscura3

P Reeder 5

FE Affinity Publisher 2

Notability 10

¥ MindNode 7

== Genius Scan 6.0

P~ Fantastical 3

w Gentler Streak
Grocery 3

Procreate for iPad

culturedcode.com
literatureandlatte.com
sparkmailapp.com
pixelmator.com
luma-touch.com
obscura.camera
reeder.app
affinity.serif.com
gingerlabs.com
mindnode.com
thegrizzlylabs.com
flexibits.com
gentler.app
smartgrocery.app

procreate.art

$9.99

$19.99

Free

$4.99

$29.99 (IAPs)
$9.99

$4.99

$19.99

$8.99

$14.99

Free (IAPs)
$4.99/month
Free (IAPs)
Free

$9.99

#194

#138

#190

#193

#186

#196

#176

#206

#174

#184

#182

#198

#199

#198

#196

T S S TS S

T0 DO (PRODUCTIVITY)
WRITING

EMAIL

PHOTO EDITOR

VIDEO EDITOR

SCREEN CAPTURE

MUSIC CREATION
PASSWORD MANAGER
DESKTOP PUBLISHING
BACKUP

VIRTUALIZATION
TIME-TRACKING
NOTE-TAKING

AUDIO AND VIDEO CONVERTER
VIRTUAL PRIVATE NETWORK

& Things 3

& Scrivener

N Spark

Luminar Neo

ﬂ Wondershare Filmora
& Screenflow 9

B Logic Pro

(5] Secrets

I Adobe InDesign
[# Carbon Copy Cloner
Bl Parallels Desktop 18
@ Tymes

/A Agenda

@ Wondershare UniConverter

@ NordveN

culturedcode.com
literatureandlatte.com
sparkmailapp.com
skylum.com
wondershare.com
telestream.net
apple.com
outercorner.com
adobe.com
bombich.com
parallels.com
tyme-app.com
agenda.com
wondershare.com

nordvpn.com

$49.99

$49

Free

$79

$109.99
$129.00
$199.99
$19.99
$20.99/month
$39.99

From $99.99
$3.99/month
Free
$49.99/year

$11.95/month
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#194

#200

#190

#194

#202

#164

#141

#188

#162

#136

#201

#169

#204

#203

#186
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Make your Mac work like new — must-try tips and
tricks for a faster, leaner machine

Gear for the great outdoor

Essential accessories for Mac, iPhone and iPad —
whether you're traveling or in the backyard

Customize your Home Screen

Make your iPhone your own with our in-depth guide

..and much more!
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PAPER REVOLUTION

68% of paper and paper-based packaging in the U.S. is
recycled into new products, one of the highest recycling rates
of any material in the country.

Sources: Americon Farest ond Poper Assaciation, 2022
U5, Environmanial Protection Agency, 2022

[®] Discover the story of paper
R www.lovepaperna.org

Scan for paper facts, activities,
v blogs and much more!




